Openl Tablets BRMS

Installation Guide
Release 5.25



Document number: TP_OpenL_IG_2.7_LSh
Revised: 03-07-2022

SOME RIGHTS RESERVED

Openl Tablets Documentation is licensed under a Creative Commons Attribution 3.0 United States License.



http://creativecommons.org/licenses/by/3.0/us/
http://creativecommons.org/licenses/by/3.0/us/
http://creativecommons.org/licenses/by/3.0/us/

Table of Contents

1

2

o =] T N 5
1.1 How This GUIE IS OFZANIZEA.......cciiiiieeeeiiiee ettt eeee e et e e e e stee e e e et e e e e sabaee e e nbaeeeesabeeeeesasteeeesnseeeeennsens 5
O N ¥ o [T oo PP 5
0 B 2 U= o = Te I [} oY ' F= Y o IS PSP 6
i NV o ToT={ ¢ o] o | Toll @] a1V =T | d o o F-3 PP 6

2T 0 = e TU T2 7 1 N 7
2.1 System Requirements for OpenL Tablets SOftWaAre ..o 7
2.2 Common Information about OpenL Tablets WebStudio INStanCes ........coccvveeiiiciieiiiiiiie e 8

Openl Tablets WebStudio Home Directory CoONfigUration ..........cccuiiiieiiiiieieiiee et esiee e eete e e stve e e e ste e e seaaee e sabeeeessaneeennnes 8

Starting OpenL Tablets WebStudio in the ClUSTEr IMOTE .........eoiiiiiiiiiiieieeee ettt sttt s 9

Sharing WebStUdIO. PrOPEITIES . ...ci ittt st e st e st e et e st e e st e e st e e easeesabeeeaseesabeesnseesabeesneenase 9

SNAIING PrOJECT HISTOIY . .uiiiiieiiit ettt et e s et e st e s a bt e st e e sa bt e e ae e e sab e e euseesabeeeaseesabeeeaseesabeeeseesabeeaneenase 9

SNANEG PrOJECT INEX 1.eeniiiiiieeitt ettt sttt et e e st esat e e s a bt e s ab e e sab e e easeesabeeeaseesabeeeaseesabeeenseesabaeeseesabaesseenase 9

Install OpenL Tablets WebStudio under Apache TOMCat ......ccccciiiiiiimenniiiiiiiiiiin.. 11
I A 10 11 =1 g =20 USSR 11
3 A 1 1 [T gAY o F= Tl o <IN o o Tor- | AR 12

Installing Apache TOMCat ON WINAOWS .......uuiiiiiiiiiiieee e e e e e e sttt e e e e e e ssatbaereeeeeesenstataeeeeeesasssereeeeessnnsssrnns 12

Installing Apache Tomcat 0n UNIX / LINUX MACRINE ....ccuiiiiiiiiiceiie ettt ettt st steeetve e saveeetveestbeeeaveesaaeenaneesnneennnes 14
3.3 Deploying OpenL Tablets WebSTUIO ... ..cciciiiiiiiie ettt e s e e e s saaae e e s sataeeessanaeee s 16

Deploying OpenL Tablets WebStudio on @ Windows Machine.........cueeriiiiiiiniieiieeieecteeee et s 16

Deploying OpenL Tablets WebStudio on a Linux Maching and MaC.........cooueeriiiiieiniienieee ettt 16
3.4 Configuring EXternal USer Database........coccuiiiieiiiieeccieee ettt ettt e e e cttte e e et e e e eeata e e e e sataeeeensaeeesentaeeesannseeens 17

Adding Drivers and Installing and Configuring the Database.........cccvvivciiiieiiiie e ee e e e e saae e 17

Configuring MySQL Database as EXtErnal USEr STOFAZE ......ccccuueiiiiiiieeeiiieeeeiiee e ertee e e ette e e e ette e e eeavaeeeebaeeeestaeeeessaeeessreaeans 20

Configuring MariaDB Database as EXTErnal USEr STOMaZE......ccuiiiiiuiieieiiieececiiee e cciee e e ette e e ettt e e eetvee e e sbaeeeeateeeeennaeeesbreaeans 20

Configuring Oracle Database as EXternal USEr STOrAZE ......eccccuveieiiiiieeeciiee ettt e e ettt e e e tte e e s ataee e sbaeeeesteeesensaeeessreaaans 22
3.5 Setting Up OpenL Tablets WebStudio with Installation Wizard..........cccceeeeiieeiiicieecciieeccree e 22

Configuring OpenlL Tablets WebStudio via JDBC CONNECLION .....cccuvieeeiiiieeeiiee e siee e e st e s e ere e e seneee e e ssaeesenteeesennneeesnneeeans 25

Configuring OpenlL Tablets WebStudio via INDI CONNECLION ......ciicuiiieeiiieeceiee e ciee et e s et e e sere e e srae e e snte e e senanaeesnneeeens 26

Configuring OpenlL Tablets WebStudio via Amazon Simple StOrage SErviCe .......cccveruieeeecieieseeeeecee e eree e e seaee e 28
3.6 Integration with External Identity ProVIiders .......cocuiiiiiie ittt eevrrre e e e e e e e e e e e e e e e eannes 28

(WoTor | IV o= g o I W LYY AV - P =T o g =T o S 29

Configuring Authentication Via ACHIVE DirCLOINY .....iui ittt e e e e ee e e e e e s e s aata e e e e e e s esnstaaeeaeeeeesnsasaeeeens 29

Configuring SiNGIE SIZN ON Via CAS..... ..ottt e e e e et e e e e e e e s ettt ta e e e e e e sesbataeseeaeseanstaaseaaesesnstbaseesesesanstanneanans 30

Configuring Single SigN ON Via SAIML SEIVET ......uiiiiiee ettt ettt e e e e et e e e e e e s et e e e e e e e seaaataaeaeeesesnstaaseeseeesanssaaaeeeans 31
3.7 Configuring Microsoft Excel Settings for Apache TOMCat .......coccviiiiiciiiiicie e 35
3.8 OpenL Tablets WebStudio CUStOMIZATION ......cciiciiiiieciiie et e e e e e e aeae e e e ataeeeenaaaeae s 36

Updating User Database CONfIGUIAtION .......c.uiiiiiiiie st tee st e e et e e e e tte e e s eaee e e e sataeeeessaeeesnbaeeesasseeeansreeesnenens 36

(@0oT oY 7 ={U T Ta Y= 8 <Ll 1V T Yo [N 36

CoNfiGUINING GOOZIE ANGIYTICS ..ocuevvieeeiiiieeciie ettt e e e et e e e et e e e st e e e e sateeeeeateee s sseeeesssaeeaanstesesssaaeeansaeeeansteeesansnaeesnnsenenns 37

Configuring Private Key for REPOSITOIY SECUITY ...eeieiiiiiiiiieee ettt e e e et e e e e e s e et e e e e e e s eeaabaaeeeaeeeesnsanaeaeans 37

Deploy OpenL Tablets Rule Services under Apache TOmCat......cccceuceirrmniiriieeierieeserreeneereennssereennssssenes 38



4.1 Downloading Preconfigured OpenL Tablets RUIE SEIVICES........uiuiiiiiiciiiee et 38

4.2 Configuring OpenL Tablets Rule Services for a Local Data SOUICE .......ccuueveecciiiieeiiieee e 38
Configuring OpenlL Tablets Rule Services via LOCal File SYStEM .....c..ooiiiiiiiiiiiiieceereeee et 38
Configuring OpenlL Tablets Rule Services via LOCal ZIP ArCRIVES .......ccocciiie ittt e s e et eaae e e e aree e 39
Configuring OpenlL Tablets Rule Services via Classpath JAR .......ooociiiiiiiiie et sere e e e e ate e e eanre e e sareeeens 39

4.3 Configuring OpenL Tablets Rule Services for a Database Data SOUICe ........coovveeeeeeeeccciiiieeeee e, 40
Configuring OpenlL Tablets Rule Services via JDBC CONNECTION .......uiieeiiiieeeiieeeccieeeeciteeeeire e e serreeestaeeessntaeessannaeesnreeeens 40
Configuring OpenlL Tablets Rule Services via JNDI CONNECION ......ccuuiiiuiiiiiiiiiieiieeeee ettt sttt e e s 40
Configuring OpenL Tablets Rule Services via AWS S3 CONNECLION .....cocuuiiiiiiiiieiieeie ettt s 41

4.4 Configuring OpenL Tablets Rule Services via GIT CONNECLION.........uvviiiiiiieiciiiee e 42

5 Install OpenL Tablets WebStudio and OpenL Tablets Rule Services on WebSphere Application Server ....44

N R o /=T =Y o LU ] =PRIt 44
5.2 Setting Up JVM Options for WebSphere AppliCation SEIVET..........eiivciiiieeiiiie ettt evree e 44
5.3  Preparing OpenL Tablets WAR FIlES .......oooc ittt e e e ettt e e e et e e e e satae e e e sasaeeesantseeesannaeeenn 45
5.4 Deploying OpenlL Tablets Web Applications on WebSphere Application Server........ccccceeeeveciiviieeeeeeeenennns 45
Deploying OpenL Tablets WebStudio on WebSphere Application SEIVET ..........ceoeciiii et e 45
Deploying OpenL Tablets Rule Services on WebSphere Application SEIVET .........cccviiiciieeeciiie e e e 46

5.5 Configuring Settings for JDBC CONNECLION ....uiiiicuiiiiiiciiieecciiee ettt ettt e e st e e e s saae e e ssatae e e ssntaeeesnnneeeen 46
5.6 Configuring Settings for INDI CONNECLION .....uiiiiciiiiiieciiie ettt et e e e srre e e s rabae e e ssataeeesnnnaeeeen 46
ConfigUrING GlODAl INDI CONTEXL ... .eeiuiieiiiiititeiiteeeite ettt ettt ettt et sab e e s bt e e s ab e e sae e e sabeeeabeesabeesabeesabeessseesateesaneesareennneess 46
CoNFIGUIING LOCAI JNDI CONTEXL ..ccuviiiiiieiieeite ettt ettt ettt ettt ettt ettt e sat e sttt e st e e s it e e sabeesae e e sabeesaeeesabeesaseesabeesaseesateesaneesabeennneesn 50

5.7 Configuring Microsoft Excel Settings for WebSphere Application Server........cccoceeeccieeeeciieeeccciieee e, 51

6 Install OpenlL Tablets WebStudio and OpenlL Tablets Rule Services on JBoss Application Server .............. 52
6.1 Deploying OpenL Tablets WebStudio on JBoss Application SEIVEr........cccvevviierieiecieecee e 52
6.2 Deploying OpenL Tablets Rule Services on JBoss Application SEIVEN ......c.cocvvierieieiiieniee e esieeecee e 52
6.3 Setting UpP @ JDBC CONNECLION .....uiiiiiiieiiiieiteee e e e ettt e e e e e ettt et e e e e e s s tbeeeeeeessannreaeeeeeeseaaannreneneeeeesannnne 53
6.4  Setting UpP @ JNDI CONNECTION. .....uiiiiiiiiieiieiee ettt e e e e ettt et e e e e e s e aber e e e e e e e s sannrebeeeeeeseasannreneneeeessannnne 53

7 Openl Tablets WebStudio and Rule Services Integration...........cccccceveeeniiiieeniiiieeecieneeecesneneseeeneeanesseenanes 56
7.1 Deploying Rules to the ProduCtion SEIVET ........c.uiii ittt sae e e e saae e e s sabae e e ssaaaeee s 56
7.2 Integrating OpenL Tablets WebStudio and OpenL Tablets Rule Services via Database Repository ........... 57

8  TroubleShOOting NOES ........ciiiieiiiiiieiirirrerreneereenesereenes e s eenssssrennsssssesnsssssennssssnennssssnennsssssenassssnennnns 58
9  Frequently Asked QUESEIONS ........cciiiieiiiiiiiiiieicrrenierrenseseenesereensssssennssssennssssnenassssnennsssseensssssnananes 59
Appendix A: Official Docker Images for OpenL Tablets ........cciiveeiiiiiimiiiiiiciiiireee e rrenees s renese s s renessseenenes 60
Appendix B: OpenL Tablets WebStudio Image Configuration for SAML.........ccccceiiiiimiiiiiemiiiinenncsnreneeeeeenenes 61

Appendix C: CORS Filter Support Enablement in OpenL Tablets WebStudio .....ccc.ccovveeiiiiieeiiiiieniiiineeenceneenenn. 62



OpenlL Tablets Installation Guide

1 Preface

Preface

Openl Tablets is a Business Rules Management System (BRMS) based on tables presented in Microsoft Excel
documents. Using unique concepts, OpenlL Tablets facilitates treating business documents containing business
logic specifications as an executable source code.

Openl Tablets provides a set of tools addressing BRMS related capabilities including OpenL Tablets WebStudio
that can be used for creating, testing, and managing business rules and business rule projects, and OpenlL
Tablets Rule Services designed for integration of business rules into customer applications.

The OpenlL Tablets Installation Guide provides instructions for installing and customizing OpenL Tablets

software. The document describes how to install OpenL Tablets under Apache Tomcat, deploy, and set up OpenL

Tablets Rule Services.

This section includes the following topics:

e How This Guide Is Organized
e Audience

e Related Information

e Typographic Conventions

1.1 How This Guide Is Organized

Information on how to use this guide

Section

Description

Before You Begin

Lists system requirements for installing and using OpenlL Tablets software.

Install Openl Tablets WebStudio under
Apache Tomcat

Explains how to install OpenL Tablets WebStudio under Apache Tomcat.

Deploy OpenL Tablets Rule Services under
Apache Tomcat

Designed for rule developers who need to use business rules as separate
web services.

Install Openl Tablets WebStudio and
Openl Tablets Rule Services on
WebSphere Application Server

Explains how to install OpenL Tablets WebStudio and OpenL Tablets Rule
Services on WebSphere Application Server.

Install OpenL Tablets WebStudio and
Openl Tablets Rule Services on JBoss
Application Server

Explains how to install OpenL Tablets WebStudio and OpenL Tablets Rule
Services on JBoss Application Server.

Openl Tablets WebStudio and OpenlL
Tablets Rule Services Integration

Explains how to set up Openl Tablets WebStudio and OpenlL Tablets Rule
Services as an integrated environment.

e Troubleshooting Notes
e Frequently Asked Questions

Provides useful information related to OpenlL Tablets installation.

1.2 Audience

This guide is mainly targeted at business users and rule experts who define, view, and manage their business
rules and rule projects via OpenlL Tablets WebStudio. Developers can also use this document to learn how to
install and set up OpenlL Tablets Rule Services.

© 2004-2021 Openl Tablets
OpenlL Tablets 5.25

Page 5 of 62



OpenlL Tablets Installation Guide Preface

Basic knowledge of Java and Apache Tomcat is required to use this guide effectively.

1.3 Related Information

The following table lists sources of information related to contents of this guide:

Related information

Title Description

[OpenL Tablets WebStudio User Guide] Describes OpenlL Tablets WebStudio, a web application for managing
OpenlL Tablets projects through web browser.

[Openl Tablets Reference Guide] Provides overview of OpenL Tablets technology, as well as its basic
concepts and principles.

http://openl-tablets.org/ Openl Tablets open source project website.

1.4 Typographic Conventions

The following styles and conventions are used in this guide:

Typographic styles and conventions

Convention Description

Bold e Represents user interface items such as check boxes, command buttons, dialog boxes,
drop-down list values, field names, menu commands, menus, option buttons, perspectives,
tabs, tooltip labels, tree elements, views, and windows.

e  Represents keys, such as F9 or CTRL+A.
e  Represents a term the first time it is defined.

Courier Represents file and directory names, code, system messages, and command-line commands.
Courier Bold Represents emphasized text in code.
Select File > Save As Represents a command to perform, such as opening the File menu and selecting Save As.
Italic e  Represents any information to be entered in a field.

e  Represents documentation titles.
<> Represents placeholder values to be substituted with user specific values.
Hyperlink Represents a hyperlink. Clicking a hyperlink displays the information topic or external source.
[name of guide] Reference to another guide that contains additional information on a specific feature.

© 2004-2021 Openl Tablets
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2 Before You Begin

This section lists system requirements for OpenL Tablets software and introduces OpenL Tablets WebStudio
instance properties. The following topics are included:

e System Requirements for OpenL Tablets Software
e Common Information about Openl Tablets WebStudio Instances

2.1 System Requirements for OpenL Tablets Software

The following table covers system requirements for installing and running OpenL Tablets software:

Software requirements

Software Requirements description

Operating systems One of the following:
e  Microsoft Windows 7+ x86/64
e Ubuntu 12.x
e Linux 3.x

Note: Openl Tablets software can potentially run on any operating system that supports Java
Virtual Machine, for example, Mac OS. This table lists operating systems on which the
Openl Tablets software is tested and supported.

Browsers One of the following:

e  Microsoft Internet Explorer 11.x
e  Firefox 60 ESR or later
e Chrome 73+

Data Bases One of the following:
e MySQL 5.5+
e MariaDB 10.2+
e MSSQL Server 2008+
e Oraclellg+
e  PostgreSQL 9.5+
Other software e Javav8/11/12 x86/64
e Apache Tomcat 7, 8.5,9
e  WebSphere Application Server 8.5
e JBossEAP7.1
Hardware requirements

e RAM 4 GB minimum.
6 GB is recommended.
e 1 GHz or faster 32-bit (x86) or 64-bit (x64) processor.
User rights requirements

Administrative permissions are required to install the software under Microsoft Windows or
UNIX system.

Note: It is highly recommended to avoid using spaces and special characters in paths.

© 2004-2021 Openl Tablets
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2.2 Common Information about OpenL Tablets WebStudio
Instances

This section provides general information about OpenL Tablets WebStudio home directory structure and
resources shared among multiple OpenL Tablets WebStudio instances. The following topics are included:

e Openl Tablets WebStudio Home Directory Configuration
e Starting Openl Tablets WebStudio in the Cluster Mode

e Sharing webstudio.properties

e Sharing Project History

e Sharing Project Index

OpenlL Tablets WebStudio Home Directory Configuration

When OpenlL Tablets WebStudio is run for the first time, by default $ {user.home}/.openl is used as the
openl.home Or OPENL_HOME directory where the application is deployed.

This folder contents depends on configuration. Example of its contents is as follows:

locks
repositories Which is a settings folder
user-workspace that contains . 1ocks folder and folders by users with .history folders

webstudio.properties file

cache
repositories that includes deploy-config and design folders

In case of multiple OpenL Tablets WebStudio instances, a shared file storage can be defined. The
openl.home.shared folder must be defined in the application.properties file before launching OpenL
Tablets WebStudio for the first time.

An example of the openl .nhome.shared folder contents is as follows:

locks

repositories Which is a settings folder

user-workspace that contains the . 1ocks folder and folders by users with .history folders
webstudio.properties file

An example of the open1.home folder contents is as follows:

cache
repositories that includes deploy-config and design folders and by default can be set to one folder
users-db, only for a local h2 database

This option is not available if OpenL Tablets WebStudio is installed using the installation wizard. In this case,
openl.home.shared is set equal to openl.home and it cannot be modified in the installation wizard.

© 2004-2021 Openl Tablets
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Starting OpenlL Tablets WebStudio in the Cluster Mode

To start OpenL Tablets WebStudio in the cluster mode, the openl.home.shared Or OPENL HOME SHARED
property must be defined properly. In the cluster mode, the same file storage can be used for multiple OpenL
Tablets WebStudio instances.

Virtual machine 1 Virtual machine 1

{ {
|

I OpenL Tablets We bStudi§ y dpenL Tablets We bStudiAo‘:
VM :‘y VM |
7 OS/drivers ?l OS/drivers
1 Hardware presentation ! Hardware presentation

Shared drive

Figure 1: Multiple Openl Tablets WebStudio instances sharing the same drive

Sharing webstudio.properties

webstudio.properties can be shared among multiple instances of OpenL Tablets WebStudio. If the
openl.home.shared path is added to application.properties before starting OpenlL Tablets WebStudio, and
it differs from the openl.home path, a separate folder is created for storing webstudio.properties file and
administrative settings can be shared among several instances of OpenL Tablets WebStudio that have one
openl.home.shared path.

Sharing Project History

Project history can be shared among multiple instances of OpenL Tablets WebStudio.
It is stored in user workspace, in the openl .home.shared folder if set up so before launching OpenL Tablets
WebStudio. Thus, users can view project history from different OpenL Tablets WebStudio instances.

Sharing Project Index

Project index can be shared among multiple instances of OpenL Tablets WebStudio to support work with the Git
non-flat structure repository from different OpenL Tablets WebStudio instances. The openl-projects.yanl file

© 2004-2021 Openl Tablets
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that contains a list of projects and their paths is now stored in repositories\settings\design of the
openl.home.shared folder, or openl.nome if the shared folder is not configured.

© 2004-2021 Openl Tablets
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3 Install OpenlL Tablets WebStudio under Apache
Tomcat

This section describes how to set up the environment for working with OpenL Tablets software and deploy
Openl Tablets WebStudio under Apache Tomcat and provides information about settings required for proper
functioning of the application.

Perform the following steps:

e Installing JDK
e Installing Apache Tomcat

e Deploying OpenL Tablets WebStudio

e Configuring External User Database

e Setting Up Openl Tablets WebStudio with Installation Wizard
e Integration with External Identify Providers

e Configuring Microsoft Excel Settings for Apache Tomcat

e Openl Tablets WebStudio Customization

3.1 Installing JDK

To install JDK, perform the following steps:

1. Download JDK.
Options are as follows:
e Download OpenJDK 11 available at https://openjdk.java.net/projects/jdk/11/.
e Download jdk-8u231 or later from
http://www.oracle.com/technetwork/java/javase/downloads/index.html to the target directory.

Further in the document, this catalog is referred to as <Java HOME>.

Note: It is highly recommended to avoid installing Java in the default Program Files directory because it can cause
problems due to space characters in the path to the folder.

For more information on the installation, see http://www.oracle.com/technetwork/java/javase/index-
137561.html.

2. Install JDK according to the instructions.

Now the environment variable Java HoME must be set to the pathname of the directory where JDK is
installed.

3. For MS Windows, set the environment variable Java HoME as follows:

1. To open the System Properties window, press <Windows> + <Pause> or right click the My Computer
icon and in the pop-up menu, select Properties.

In the Advanced tab, click Environment Variables.
In the System variables area, click New.
In the Variable name field, enter JAVA_HOME.

In the Variable value field, enter the path to the directory where JDK is installed, for example,
C:\Java\jdkl.8.0 231.
6. Click OK to complete.

ok~ wD

© 2004-2021 Openl Tablets
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4. For Unix/Linux environments, assuming the target directory is /usr/1ib/jvm/jdk1.8.0 231, to set up the
environment variable Java HoME for a single user, proceed as follows:

1. Logintothe account and open .bash profile:nano ~/.bash profile.
2. Add the following line:
export JAVA HOME=/usr/lib/jvm/jdk1l.8.0 231.

3. Add or correct the system PATH as follows:
export PATH=$PATH:$JAVA HOME/bin

4. To save, press CTRL+0 and then press CTRL+X to exit.

5. For Unix/Linux environments, assuming the target directory is /usr/1ib/jvm/jdk1.8.0 231, to set up the
environment variable gava HoME for all users, proceed as follows:

1. Loginasrootandopenthe nano /etc/profile profile.
2. Add the following line:

export JAVA HOME=/usr/lib/jvm/jdk1l.8.0 231.
3. Add or correct the system PATH as follows:

export PATH=$PATH:$JAVA HOME/bin.

3.2 Installing Apache Tomcat

Apache Tomcat can be installed from a ZIP file or using Windows Service Installer. The following topics are
included in this section:

e |nstalling Apache Tomcat on Windows
e |nstalling Apache Tomcat on UNIX / Linux Machine

Installing Apache Tomcat on Windows
This section describes how to install Apache Tomcat on Windows and includes the following topics:

e Installing Apache Tomcat from Zip File
e |Installing Apache Tomcat Using Windows Service Installer

Installing Apache Tomcat from Zip File
To install Apache Tomcat 7.0.x or later, proceed as follows:

1. Open Apache Tomcat home page at http://tomcat.apache.org/index.html.

2. Inthe left-hand Download menu, click the latest available Tomcat version.

3. Locate the Binary Distributions area and in the Core list, click on the ZIP file corresponding to the required
Windows version.

4. Save the ZIP file in a temporary directory.

5. Extract the downloaded ZIP file into the target folder on the computer.
This folder is referred to as <tomcaT _noME> further in this document.

6. For Tomcat web server 7.0, to configure JVM options, open the TOMCAT HOME/conf/server.xml file and
add the URIEncoding="UTF-8" attribute for all <connector> elements.

For example:

<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000" redirectPort="8443"
URIEncoding="UTF-8"/>

© 2004-2021 Openl Tablets
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Installing Apache Tomcat Using Windows Service Installer

This section describes how to install Apache Tomcat using Windows Service Installer.

Note: It is not recommended to select this type of installation if planning to edit rule tables in Excel files from OpenL
Tablets WebStudio as described in [OpenL Tablets WebStudio User Guide], the Modifying Tables section. This type
of installation requires additional setup. To solve this issue, contact your OpenL Tablets administrator.

Note: For Openl Tablets administrator: to enable editing rule tables in Excel files from OpenlL Tablets WebStudio, enable
the Allow service to interact with desktop Tomcat service option using MMC or from the command line.

Proceed as follows:
1. Navigate to the Apache Tomcat site at http://tomcat.apache.org/index.html and in the left-hand Download

menu, click the latest available Tomcat version.

2. Locate the Binary Distributions area and in the Core list, click the 32-bit/64-bit Windows Service Installer
link.

Save the apache-tomcat exe file in a temporary folder.

Run the exe file and follow the instructions of the installation wizard.
Click Next.
In the License Agreement window, click | Agree.

o g bk w

In the Choose Components dialog, leave the default Normal type of installation.

Experienced Tomcat users can select another installation type in the drop-down list.

In the Configuration dialog, proceed with default values.

In the next window, review the folder where Tomcat will be installed, the Destination Folder.

This folder is referred to as <ToMcaT HOME> further in this document.

9. Click Install to start the installation.

10. Click Finish to complete.

As a result, Apache Tomcat is installed and started on the user’s computer. In the Notification Area located

next to the clock, the icon appears. Tomcat is managed by using this icon or from the Start menu.

11. To configure JVM options for Tomcat, in the Notification area, right click the Apache Tomcat icon and select
Configure; or click Start > All Programs > Apache Tomcat 7.0 > Configure Tomcat.
The Apache Tomcat Properties dialog appears.

12. Click the Java tab and in the Java Options text box, add the following lines:

-Xms512m

-Xmx2000m

-XX: +UseConcMarkSweepGC
-XX:PermSize=128m
-XX:MaxPermSize=512m

Note that every option must be manually entered in a separate row.
13. Click Apply and then click OK.
14. To restart Tomcat, in Notification Area, right click the Tomcat icon and select Stop service.

The Tomcat icon changes to .

15. Select Start Service.
Alternatively, Tomcat can be restarted from the General tab in the Apache Tomcat Properties window
which appears after selecting Start > All Programs > Apache Tomcat 7.0 > Configure Tomcat.

From this point, OpenlL Tablets WebStudio can be run as described in Deploying OpenL Tablets WebStudio.
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Installing Apache Tomcat on UNIX / Linux Machine

This section describes how to install Apache Tomcat on the UNIX or Linux machine and includes the following
topics:

e |Installing Apache Tomcat from Repository
e Installing Apache Tomcat from ZIP File
e Configuring JVM Options for Tomcat on UNIX / Linux Machine

Installing Apache Tomcat from Repository

This section describes how to install Apache Tomcat from repository as a service on Ubuntu 12.x.
Note: All commands must be entered into a terminal window using an account with sudo privileges.
Proceed as follows:

1. Open aterminal window and enter the following:

sudo apt-get install tomcat?

2. Start Tomcat with the next command:
sudo /etc/init.d/tomcat7 start

All necessary folders must be located in /var/1ib/tomcat7.
3. To ensure that Tomcat works properly, open the browser and enter http://localhost:8080.
If all is correct, Apache Tomcat displays the welcome page with a message resembling the following:
If you're seeing this, you've successfully installed Tomcat. Congratulations!
If the 404 error appears, try to restart Tomcat as follows:

sudo /etc/init.d/tomcat7 restart
Alternatively, stop Tomcat by entering the following command in command line and then start it as
described previously:

sudo /etc/init.d/tomcat7 stop

Installing Apache Tomcat from ZIP File

This section describes how to install Apache Tomcat on Ubuntu 12.04 and Centos 6.3. The instructions are valid
for other Linux distributions with small changes.

Proceed as follows:

1. Download the appropriate Tomcat archive file, ZIP or tar.gz archive, from its official website
http://tomcat.apache.org/download-70.cgi to the required user folder.

In this example, Tomcat 7.0.39 is downloaded to the /home/myuser folder.
2. Open a terminal window and change directory to the folder containing the Tomcat archive.
3. Extract the archive by entering the following command in the terminal, modifying the Tomcat version as
required:
tar -zxvf apache-tomcat-7.0.39.tar.gz
The apache-tomcat-7.0.39 folder appears. For example:
/home/myuser/apache-tomcat-7.0.39
4. Change directory to the tomcat/bin:
cd apache-tomcat-7.0.39/bin
5. Make sure all ». sh files are executable, that is, they have r in all positions to the left of the file name, for
example, —IrWXr—XIr-X.
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For that, in terminal, enter the following:
1s —-1la

The following information is displayed:

bahdanau bahdanau 40896

bahdanau bahdanau 4896

bahdanau bahdanau 28865

bahdanau bahdanau 13217 :45 catalina.bat
bahdanau bahdanau 19189 :45 catalina.sh
bahdanau bahdanau 2121 :46 catalina-tasks.xml
bahdanau bahdanau 24239

bahdanau bahdanau 208759

bahdanau bahdanau 2131 :45 configtest.bat
bahdanau bahdanau 1982 :45 configtest.sh
bahdanau bahdanau 1342 :45 cpappend.bat
bahdanau bahdanau 7492 :45 daemon.sh
bahdanau bahdanau 2178 :45 digest.bat
bahdanau bahdanau 20821 :45 digest.sh
bahdanau bahdanau 3264 :45 setclasspath.bat
bahdanau bahdanau 3524 :45 setclasspath.sh

P

( 9
1
1
(1
1
1
1
1
¢ 1
1
x 1
1
¢ 1
1
x 1

Figure 2: Openl Tablets package is added

If some sh files are not executable, enter the following command:
chmod +x ./*.sh

Run the sturtup. sh file as follows:

sh ./startup.sh

In the browser, enter the following URL:

http://localhost:8080

If the installation is completed successfully, the Apache Tomcat welcome screen appears. The next thing to
be done is to configure JVM options for Tomcat.

Configuring JVM Options for Tomcat on UNIX / Linux Machine

To configure JVM options for Tomcat on a UNIX / Linux machine, proceed as follows:

1.

For UNIX, create TOMCAT HOME/start.cmd file and type the following:

export JAVA OPTS="SJAVA OPTS -Xms512m -Xmx2000m -XX:+ UseConcMarkSweepGC -XX:PermSize=128m
-XX:MaxPermSize=512m"

Locate the TOMCAT HOME/conf/server.xml file and add the URIEncoding="UTF-8" attribute for all
<Connector> elements.

For example:

<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000" redirectPort="8443"
URIEncoding="UTF-8"/>

From this point, deploy OpenlL Tablets WebStudio as described in Deploying OpenL Tablets WebStudio.
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3.3 Deploying OpenL Tablets WebStudio

This section describes how to deploy and run OpenlL Tablets WebStudio under Tomcat.
The following topics are included:

e Deploying OpenL Tablets WebStudio on a Windows Machine
e Deploying OpenL Tablets WebStudio on a Linux Machine and Mac

Deploying OpenlL Tablets WebStudio on a Windows Machine
This section describes how to deploy and run OpenlL Tablets WebStudio under Tomcat on a Windows machine.
Proceed as follows:

1. Go to the http://openl-tablets.org/downloads page.
2. Click the appropriate OpenL Tablets WebStudio WAR link.
3. Save the file in a temporary folder and then copy the OpenlL Tablets WebStudio WAR file.
For example, openl-tablets-webstudio-X.X.X.war to the <TOMCAT HOME>\webapps folder.

4. Run Tomcat as follows:

e If Tomcat is installed from the ZIP file, in ToMcAT HOME\bin, click the startup.bat file.
e If Tomcat is installed using Windows Service Installer, restart Tomcat as described in Installing Apache
Tomcat Using Windows Service Installer.

Tomcat unpacks the WAR file into the <ToMCAT HOME>\webapps\<war file name> folder. For example, for
5.9.4 version the target folder can be <TOMCAT HOME>\webapps\openl-tablets-webstudio-5.9.4. For
convenience, the folder can be renamed as needed but remember that this name is used to launch OpenL
Tablets WebStudio under Tomcat.

From this point on, run Openl Tablets WebStudio with default settings or make additional customizations by
changing the user mode and configuring an external user database as described in [OpenL Tablets Rule
Services Usage and Customization Guide].

5. To run Openl Tablets WebStudio, in the browser, enter the following URL:
http://localhost:8080/<WAR file name>
That is, for this example, the URL is http://localhost:8080/openl-tablets-webstudio-5.9.4.
Openl Tablets WebStudio is opened in the browser on the Welcome to Installation Wizard page. The wizard
will guide through the setup process as described in Setting Up OpenL Tablets WebStudio with Installation
Wizard. When setup is complete, use OpenL Tablets WebStudio to create new projects or download existing
ones.

6. After a new release of the OpenL Tablets WebStudio is installed, click CTRL+F5 or clear cookies and cash
manually to reload the page in the browser.

Deploying OpenL Tablets WebStudio on a Linux Machine and Mac
To install OpenL Tablets WebStudio under Linux and Mac OS, perform the following steps:

1. Create the <oPENL HOME> folder where the application will be deployed as follows:
sudo mkdir /<OPENL HOME>

2. Change access rights for this folder by entering the following command in the command line:
sudo chmod 775 -R /<OPENL HOME>
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3. Change the owner for this folder:
sudo chown tomcat7:tomcat?7 /<OPENL_ HOME>

4. Download OpenlL Tablets WebStudio WAR file from https://github.com/openl-tablets/openl-
tablets/releases/ to a temporary folder.

5. Copy the downloaded WAR file to the Tomcat webapps folder:

cp /home/myuser/Downloads/<openl-tablets-webstudio-
XXxXx.war>/home/myuser/<TOMCAT HOME>/webapps/webstudio.war

6. To stop Tomcat, run the following command from /home/myuser/<TOMCAT HOME>/bin :
sh shutdown.sh
7. Start Tomcat from the same folder as follows:
sh startup.sh
8. Inthe browser, enter http://localhost:8080/webstudio.
If deployment is completed without errors, the OpenL Tablets WebStudio Installation Wizard described in
the next step is opened in the browser.
If encountering any problems, for more information, see the following log files:

home/myuser/<TOMCAT HOME>/logs/catalina.out and
home/myuser//<TOMCAT HOME>/logs/webstudio.log

3.4 Configuring External User Database

This step is only required if a user is planning to work in multi-user application modes such as Multi-user, Active
Directory, SSO: CAS or SSO: SAML. For more information, see Setting Up OpenL Tablets WebStudio with
Installation Wizard and use an external database such as MySQL for managing users in OpenL Tablets
WebStudio.

By default, OpenL Tablets WebStudio can run using an internal user database based on the HSQLDB database
engine. It is a good idea to use the internal user database for demonstration purposes because it is provided by
default and requires no additional setup. But in this case, all user management changes will be lost after server
restart.

In a production environment, it is strongly recommended to use an external database.

Note: For more information on supported platforms, see http://openl-tablets.org/.

The following topics are included:

e Adding Drivers and Installing and Configuring the Database
e Configuring MySQL Database as External User Storage

e Configuring MariaDB Database as External User Storage

e Configuring Oracle Database as External User Storage

Adding Drivers and Installing and Configuring the Database

Before configuration, perform the following steps:

1. Add the appropriate driver library for a database in OpenL Tablets WebStudio to \WEB-INF\1ib\.
Alternatively, locate required libraries directly in \<ToMCAT HOME>\1ib with other Tomcat libraries.
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Driver name for appropriate databases

Database Driver

MySQL mysgl-connector-java-5.1.31.jar
MariaDB mariadb-java-client-2.0.1.jar
Oracle ojdbc6.jar

MS sQL mssqgl-jdbc-7.2.2.jre8.jar

PostgreSQL postgresgl-9.3-1100.jdbc4.jar

For more information on URL value according to the database type, see the URL value according to the
database type table in Setting Up OpenL Tablets WebStudio with Installation Wizard.

2. Install the database, defining login and password and creating a new schema or service.

Ensure all database settings are completed.
3. Start OpenL Tablets WebStudio and in the third step, select a Multi-user, Active Directory or SSO mode.
4. Define database URL, username, and password.

Configure database:;

Set up a database to be used for managing users in Openk Tablets WwebStudio,
Please contact vour Systern Adrinistrator for this information if necessary,

Catabase URL | jdbcooraclethin:@localhost 1521:0rcl

Login: apenl
Password: wnmnn
Prev

Figure 3: Creating a connection to the Oracle database in the installation wizard

5. Click Finish to close the wizard when the installation is complete.

6. Login with credentials of a default user created in the third step of the installation wizard, in the Configure
initial users section.

Note that even after configuring the database as user storage, a default user is available for login. The
default user can manage user settings in OpenlL Tablets WebStudio, for example, create a user or add
privileges to a user. All user management activities can be performed via the OpenL Tablets WebStudio UI,
in the Admin > User Management section.
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Username TestUser
Password’  sesseenn
Fist Name
Last Name
Testers
Deployers
£y Deveiopers
Groups
¥ Analysts
Acmurstratons

BWers

Figure 4: Managing users in the User Management section of OpenL Tablets WebStudio

Right after applying changes in OpenlL Tablets WebStudio, the updates are applied to the database. A user can
log in and work under a newly created account in OpenL Tablets WebStudio.

Note: During installation, several tables are created in the database. If the same tables exist in the database from the
previous usage, a conflict occurs. To avoid this situation, the following tables must be removed:

e ACCESSCONTROLENTRY
e GROUP2GROUP
e OPENLUSER

schema_version

e USER2GROUP

e USERGROUP

e HIBERNATE_SEQUENCE table that has SEQUENCE_OWNER=0OPENL

The previous steps describe configuration when a user starts OpenlL Tablets WebStudio for the first time.
Otherwise, in the openl\user-workspace folder, the following changes must be made:

1. Inthe system-settings folder, locate the db.properties configuration file and edit it described in the
following example for the Oracle database:

D db properties

db.url = jdbc:oracle:thin:@localhost:1521:openltest

db.user = openl

db. password = open]

db.driver = oracle. jdbc.driver.oracleDriver
db.hibernate.dialect = org.hibernate.fdialect.oraclelOgpialect
db.validationQuery = SELECT 1 FROM dual

db.url.separator = @

Figure 5: Configuration file with Oracle database settings
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2. Inthe system.properties file, set variable user.mode = multi.

Configuring MySQL Database as External User Storage
This section explains how to set up a MySQL database. Proceed as follows:

1. Go to http://dev.mysgl.com/downloads/mysql/.

2. Select the appropriate MSI Installer for system configuration and click Download.

For example, Windows (x86, 32-bit), MSI Installer may be needed. It is recommended to use ZIP Archive
version since it is intended for advanced users.

3. Inthe next window, register or log in to the MySQL site.
This step can be skipped, and users can proceed to No thanks, just start my download! link.

4. Inthe next window, select Save File and save the .msi file in a target folder.

5. Navigate to the folder containing the .ms1i file and double click the file to start the installation process.
The MYSQL Server Setup Wizard Welcome window appears.

6. Follow the wizard steps leaving the default values and clicking Next to proceed.

7. Click Finish to close the wizard when installation is complete.

Note: Itis recommended to configure the database server to use the UTF-8 character set.

When MySQL is successfully installed on the user’s computer, an empty database for OpenL Tablets
WebStudio in MySQL must be created and permissions to modify this database granted to the user from
which the OpenlL Tablets WebStudio will work with this database.

8. To open MySQL Command Line Client, select Start > All Programs > MySQL > MySQL Server 5.5 > MySQL
Command Line Client and enter the following commands:
CREATE USER openl user IDENTIFIED BY 'openl password';
CREATE DATABASE openl CHARACTER SET utf8;
GRANT ALL PRIVILEGES ON openl.* TO openl user;

Configuring MariaDB Database as External User Storage

This section explains how to set up an MariaDB database. Proceed as follows:

1. Go to https://downloads.mariadb.org.

2. Select the appropriate version and click Download.

3. Select the appropriate MSI Installer for system configuration and click Download.

4. In the next window, select Save File and save the .msi file in a target folder.

5. Navigate to the folder containing the .msi file and double click the file to start the installation process.
The MariaDB Setup Wizard Welcome window appears.

6. Follow the wizard steps leaving the default values and clicking Next to proceed.

7. Define password for a root user.

8. Create a database.
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j!_{‘;! Database settings = ——
Default instance properties ://_j
MariaDB 10.2 (x64) database configuration . ;
MariaDB

Install as service

Service Mamne:! Maria

Enable networking

TCP port: ISSD?

Innodb engine settings

Buffer pool size: 2045 MG

Page size: KE

[ Back ” Mexk ] [ Cancel

Figure 6: Setting properties for the MariaDB database

9. Click Finish to close the wizard when the installation is complete.

10. Start HeidiSQL application.

11. Click New to create a session.

12. Select the Prompt for credentials check box and define a database port.

@ Sessicn manager B |-

Session narne « &7 Settings | % Advanced ||ﬂ;| Statisticsl
| t‘,{ Unnarned *

Netwark type: (MySQL (TCP/P) -|

Hostname J I 127001

DPromptforcredentiaIs

Use Windows authentication

User: root
Password: ..
Por: 3307 =

[T Compressed client/server protacol
Databases: Separated by sernicaolon v

Comment:

’New |V]’ Sawe ][ Delete ] Open H Cancel H kdore |Vl

Figure 7: Creating a connection to the MariaDB database

13. Click Open and save the changes.
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Configuring Oracle Database as External User Storage

This section explains how to set up an Oracle database. Proceed as follows:

1. Go to http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html.

2. After registration, select the appropriate version and system configuration, and click Download.
3. Unzip 2 archives in one folder and click the exe file.
4. Configure the database and define a username and password.

These values will be used further for configuration.

5. To improve work with database, download Oracle SQL Developer at
http://www.oracle.com/technetwork/developer-tools/sql-developer/overview/index.html.

In this section, as an example, Oracle SQL Developer 3.2.2 is used.
6. Start Oracle Workbench and create a connection or select an existing database connection.

' '
Q New / Select Database Connection &

Copnection Name My _connection?|
Username openl
Password venee

Saye Password

Orade  Access

Connection Type |Basic v! Role |default ¥

Hostname locahost
Port 1521
*) SID openitest
Service name

OS Authentication Kerberos Authentication Proxy Connection

Status :

3

Save ‘ Clear Test Connect | Cancel

N o,

Figure 8: Creating a connection to the Oracle database

7. Enter username and password values defined when installing the database.

3.5 Setting Up OpenlL Tablets WebStudio with Installation
Wizard

This topic describes the steps that must be taken after the first run of OpenL Tablets WebStudio under Tomcat
or WebSphere Application Server. For more information, see Install OpenL Tablets WebStudio and OpenL
Tablets Rule Services on WebSphere Application Server. Accept the default options provided by the wizard by
clicking Next to move to the next step or change the options as required and click Next to proceed.

Proceed as follows:

1. Inthe Welcome to OpenL Tablets WebStudio Installation Wizard window, click Start.
2. Inthe next window, specify a working directory for OpenlL Tablets.
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By default, the following directory is displayed:

$S{user.home}/.openl

This folder is referred to as <oPENL_HOME> in the documentation. It is highly recommended not to use the
system drive for that.

3. Click Next to proceed.

4. Specify deployment and design repositories:

Connection types for setting up design and deployment repositories

Type Description

Database The repository is located in a database installed either local or remote. The Repository URL field

(JDBC) displays URL for access to the database.

Database The repository is located in a database installed either locally or remotely. The Repository URL

(JNDI) field displays URL for accessing the database. Configuration settings are located in configuration
files of the web server application.

AWS S3 The repository is located in Amazon Simple Storage Service (AWS S3). A “bucket” is a logical unit of
storage in AWS S3 and is globally unique. Choose a region for storage to reduce latency, costs etc.
An Access key and a Secret key are needed to access storage. If empty, the system will retrieve it
from one of the known locations as described in AWS Documentation. Best Practices for Managing
AWS Access Keys. The Listener period is the interval in which to check repository changes, in
seconds.

Git The Git repository is a version control system. The Git repository can be configured as local or

remote. The URL field displays URL for the remotely located Git repository or file path to the
repository stored locally. The Local path identifies the folder where a Git repository local copy is
stored. For more information on connection settings, see [OpenL Tablets WebStudio User Guide].
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If deploy configuration must be stored in a separate repository, not in Design repository, the Use Design
Repository check box must be cleared and required parameter values must be provided.

The following table explains URL values according to the database type:

URL value according to the database type

Database URL value

MySQL, jdbc:mysqgl://[host] [:port]/ [schema]

MariaDB

Oracle jdbc:oracle:thin:@//[ host] [:port]/service

MS SQL jdbc:sqglserver://[serverName[\instanceName] [:port]] [;property=value[;propert

y=value]]

PostgreSQL jdbc:postgresql://[host] [:port]/[schema]

For more details about how to configure the repository of a specific type, please refer to the corresponding
subchapter below:

e Configuring OpenlL Tablets WebStudio via JDBC Connection

e Configuring OpenlL Tablets WebStudio via JNDI Connection

e Configuring OpenlL Tablets WebStudio via Amazon Simple Storage Service

For more information on repository security, see [OpenL Tablets WebStudio User Guide], the Repository
Settings section.

5. Click Next.
6. Select a user mode as described in the following table:

User modes

Mode Description

Demo This is a multi-user mode with the list of users predefined in the default database. The database
does not require additional setup. All changes in the database will be lost after the application
restart.

Single-user Only the user currently logged on to the computer can work with the OpenL Tablets WebStudio.
For more information on the single user mode, see [OpenL Tablets WebStudio User Guide].

Multi-user Multiple users can run OpenL Tablets WebStudio with their unique names. WebStudio is used to

(recommended) authenticate and manage user credentials/permissions with External database.

Active Directory  Multiple users can run OpenlL Tablets WebStudio using their unique user names. Active Directory
will be used to authenticate and manage user credentials.

SSO: CAS Multiple users can run OpenL Tablets WebStudio using their unique user names. CAS (Central
Authentication Service) server will be used to authenticate and manage user credentials.

SSO: SAML Multiple users can run OpenL Tablets WebStudio using their unique user names. SAML (Security
Assertion Markup Language) supporting Identity Provider server will be used to authenticate and
manage user credentials.

For Active Directory, SSO: CAS, SSO: SAML, user modes proceed as described in Integration with External
Identity Providers.

7. If Multi-user, Active Directory, SSO: CAS or SSO: SAML mode is selected, in the Configure database area
that appears, modify the database parameters as follows:
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Database parameters

Parameter Description

Database URL Enter the URL for the selected database.

Login / Password Username and password specified for the database as defined in Configuring External User
Database.

8. Click Finish to complete setup.

As a result, for the Demo, Multi-user, Active Directory, SSO: CAS and SSO: SAML modes, the login screen
appears for entering user’s credentials to start working with OpenL Tablets WebStudio. If the openl.home
registry variable is defined, upon OpenL Tablets WebStudio update, after replacing the war file, re-running
installation wizard is not required as the fact of configuration is recorded in the system registry. However, if
there are multiple instances of OpenL Tablets WebStudio installed on the same computer, OpenlL Tablets
WebStudio must be run via system properties.

For a list of users predefined in the Demo application mode, see [OpenL Tablets WebStudio User Guide], User
Management > Manage Users.

Configuring OpenL Tablets WebStudio via JDBC Connection

Configure design and deployment repositories settings on the second step of OpenL Tablet WebStudio
installation wizard as follows:

1. Select JDBC as the type of the connection database (JDBC).

2. Provide URL and authentication data.

If the Deployment repository is created in an OpenL Tablets version older than 5.20, the Version in
deployment name check box must be selected to enable backward compatibility.
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Deployment Repositories

Deployment storages of deployed rule projects where solution applications use them.

Name: * Deployment

Type: * Database (JDBC) ]
URL: * jdbc:oracle:thin: @localhost:1521:orcl
Secure connection: V]

Login: OPENL

Password: Ty

Version in deployment name: £

Create Deployment Repository = Connect To Deployment Repository

Prev

Figure 9: Setting up a JDBS connection using the installation wizard

Configuring OpenlL Tablets WebStudio via JNDI Connection
To configure the Openl Tablets WebStudio via JNDI connection, perform the following steps:

e Configuring Resources for JNDI Context
e Configuring Settings in Openl Tablets WebStudio

Configuring Resources for JNDI Context
Resource settings must be configured before deploying the application. Proceed as follows:

1. Openthe \conf\context.xml file in Apache Tomcat and add the Resource tag as described in the following
examples.

For the Oracle database, an example is as follows:

<Resource name="jdbc/oracledJNDI” auth=”Container”
type="javax.sqgl.DataSource” username="user” password="password”
driverClassName="oracle.jdbc.OracleDriver”
url="jdbc:oracle:thin:@localhost:1521:0rcl”
maxActive="8"

/>
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For the MySQL database, an example is as follows:

<Resource name="jdbc/mysqlJNDI” auth="Container” type="javax.sgl.DataSource”
maxActive="100" maxIdle="30"” maxWait="”10000"
username="javauser” password="javadude”
driverClassName="com.mysqgl.jdbc.Driver”
url="jdbc:mysqgl://localhost:3306/javatest”
/>

For the MS SQL database, an example is as follows:

<Resource name="jdbc/mssqglIJNDI” auth="Container”
type="javax.sql.DataSource” username="wally” password="wally”
driverClassName="com.microsoft.sqglserver.jdbc.SQLServerDriver”
url="jdbc:sqglserver://localhost;DatabaseName=mytest;SelectMethod=cursor;”
maxActive="8"

/>

For the PostrgeSQL database, an example is as follows:

<Resource name="jdbc/postgres” auth="”Container”
type="javax.sql.DataSource” username="postgres” password="Passwordl”
driverClassName="org.postgresqgl.Driver”
url="jdbc:postgresqgl://localhost:5432/postgres”
maxActive="8"

/>
2. Save the context.xml file.

Configuring Settings in OpenlL Tablets WebStudio

Configure design and deployment repositories settings on the second step of OpenL Tablets WebStudio
installation wizard as follows:

1. Select JNDI as the type of the connection database.

2. Entera URLin the java:comp/env/<resource name> format.
Definition of the authentication data, that is, login and password, is not required in the installation wizard
because this information is set in context.xml file already.

3. If the Deployment repository was created in an OpenL version older than 5.20, the checkbox “Version in
deployment name” must be checked to enable backward compatibility
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Deployment Repositories

Deployment storages of deployed rule projects where solution applications use them.

Name: * Deployment
Type: * Database (JNDI) B
URL: * java:comp/env/jdbc/deploymentDB

Secure connection: (]

Version in deployment name: ||

Create Deployment Repository  Connect To Deployment Repository

Figure 10: Setting up JNDI connection with installation wizard

Configuring OpenlL Tablets WebStudio via Amazon Simple Storage Service

Configure design and deployment repositories settings on the second step of OpenL Tablets WebStudio
installation wizard as follows:

1. Select AWS S3 as the type of connection.
2. Specify the following information:

AWS S3 parameters

Parameter Description

Bucket name Enter the name of the bucket in which your data resides.

Region name Select the name of the AWS region in which your bucket resides.

Access key Enter your Amazon AWS access key.

Secret key Enter your Amazon AWS secret access key.

Listener period The time, in seconds, to wait for the Amazon server to respond.

(sec)

Version in Select the Version in deployment name check box for backward compatibility if the

deployment name  geployment repository is created in an OpenL Tablets version older than 5.20.

3.6 Integration with External Identity Providers

To enhance sign in options for users, a third-party authentication can be established between organization
authentication systems and OpenL Tablets WebStudio. After enabling third-party authentication, users can sign
into OpenL Tablets using their organizational credentials.

The following topics are included in this section:
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e Local vs. External User Management

e Configuring Authentication via Active Directory
e Configuring Single Sign On via CAS

e Configuring Single Sign On via SAML Server

Local vs. External User Management

Openl Tablets WebStudio allows selecting where user permissions are managed in the case of integration with
external identity providers. The following options are available:

e local user management
An administrator can create any groups and manage authenticated user permissions in OpenL Tablets
WebStudio.

e external user management

User groups are managed in Active Directory or SSO. Configure OpenlL Tablets groups equal to Active
Directory or SSO groups in step 4 of the installation wizard. To configure OpenL Tablets groups, proceed as
described in [OpenL Tablets WebStudio User Guide], Managing Groups section.

For any of these options, first, initial users must be defined in the Configure initial users section that appears in
the third step of the installation wizard. Proceed as follows:

1. Provide at least one user to be granted administration privileges in the Administrators field.
2. Select the All authenticated users have View access check box to grant viewer privileges by default.

Configure initial users:
Add comma separated users with administrator privileges and make a decision if a new users will have View Access

to WebStudio

Administrators; * openlidmin

5y

All authenticated users have View access &

Figure 11: Configuring initial users

Configuring Authentication via Active Directory
This section explains how to set up authentication via Active Directory. Proceed as follows:
1. Select Local user management or External user management.

The steps required for this configuration are described in Local vs. External User Management.

2. Specify Active Directory domain and URL.

3. To verify connection to Active Directory, enter credentials of the existing Active Directory user and click
Check Connection.
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Configure Active Directory:

p an Active Directory to use for managing users in OpenlL Tablets WebStudio.
se contact your System Administrator for this information if necessary.

Active Directory domain: *  ldapserver.com

Active Directory URL: ® idap:iNdapserver 3263

Login and Password are used to check connection to Active Directory. They will not be saved anywhere.
Login: openlidmin

Password: EEsEEEEEE

Check connection

Figure 12: Configuring authentication via Active Directory

Configuration also can be defined via properties as follows:

security.ad.domain=1ldapserver.com

security.ad.server-url=1ldap://ldapserver:3268
security.ad.groups-are-managed-in-studio=false

security.ad.default-group=Viewers
security.ad.search-filter= (& (objectClass=user) (userPrincipalName={0}))
security.ad.group-filter= (& (objectClass=group) (member:1.2.840.113556.1.4.1941:={2}))

Configuring Single Sign On via CAS
This section explains how to set up authentication via CAS. Proceed as follows:
1. Select Local user management or External user management.

The steps required for this configuration are described in Local vs. External User Management.

2. Define the following parameters:

CAS configuration parameters

Parameter Description

WebStudio server URL for OpenlL Tablets WebStudio.

URL

CAS server URL URL for the selected CAS server.

Attribute for First CAS attribute for the first name. Keep it blank if the CAS server does not return this
Name attribute.

Attribute for Second CAS attribute for the second name. Keep it blank if the CAS server does not return this
Name attribute.

Attribute for Groups CAS attribute for groups. Keep it blank if the CAS server does not return this attribute.

Applicable for Local user management only.

Note: Contact CAS server administrator for attribute names information.
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Configure CAS:
Set up a CAS to use for managing users in Openl Tablets WebStudio.

Please contact your System Administrator for this information if necessary.

WebStudio server URL: * https:iMocalhost: 5443/ webstudic

CAS server urly * hitps./icaszerver 8d43/cas
Attribute for First Mame: givenMame
Attribute for Second Name: | =econdMame

Attribute for Groups: ™ userGroup

Figure 13: Configuring CAS

Configuring Single Sign On via SAML Server

This section explains how to set up authentication via the SAML server. Proceed as follows:

1. Select Local user management or External user management.
The steps required for this configuration are described in Local vs. External User Management.
2. Define the following parameters:

SAML configuration parameters

Parameter

Description

WebStudio server
URL

URL for OpenL Tablets WebStudio.

Entity ID

Entity identifier. Alternatively, its value can be set for the security.saml.entity-id property, in
the webstudio.properties file.

An administrator must add the same entity ID to the clients list on the server which serves as
an identity provider instance before setting it up in OpenlL Tablets WebStudio.

Adding the Entity ID parameter allows using several OpenL Tablets WebStudio instances on the
same server with one Keycloak server.

Metadata trust
check

Identifier that is set by default to true for verifying metadata signature. When metadata is not
signed, the value must be set to false to disable verification.

Max
authentication age

Maximum time between user authentication and processing of an authentication statement.
The value is in seconds.

SAML server
metadata URL

URL of the metadata XML file of the Identity Provider.

Request timeout

Time, in milliseconds, to wait for the metadata server to respond.

SAML remote
server X509
certificate

PEM Base-64 encoded string, which contains a public key for SAML IDP Server. The begin and
end tags are not required.

Authentication
Contexts

Comma separated list of authentication contexts that IDP is allowed to use when
authenticating a user. This value can be left blank.
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SAML configuration parameters

Parameter

Description

Local logout

Identifier that can be set to true for local logout, logging out only from OpenL Tablets
WebStudio, or false for global logout, logging out from all services using this IDP.

Attribute for
Username

SAML attribute for a username. Keep it blank if SAML server does not return this attribute, or if
default algorithm for username retrieval must be used.

Attribute for First
Name

SAML attribute for the first name. Keep it blank if SAML server does not return this attribute.

Attribute for
Second Name

SAML attribute for second name. Keep it blank if SAML server does not return this attribute.

Attribute for
Groups

SAML attribute for groups. Keep it blank if the SAML server does not return this attribute. This
parameter is applicable to external user management only.

Is load-balancer or
reverse-proxy
used in front of
the local
application

Identifier that must be set to true if load-balancer or reverse-proxy are used in front of the
Openl Tablets WebStudio instance server.

Scheme of the
load-balancer

Scheme of the load-balancer server. The values are http or https.

Server name of
load balancer
server

Server name of the load balancer.

Port of the load
balancer

Port of the load balancer.

Include port to the
requestURL

Identifier that, if set to true, denotes whether the port will be used in construction of load
balancer requestURL.

Context path of
the load balancer

Context path of the load balancer. The value must be started with slash.
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Configure SAML:

Set up SAML to use for managing users in Openl Tablets WebStudio.

Flease contact yvour System Administrator for this information if necessary.

WebStudio server URL: *
Metadata trust chech:

Maw authentication age in secands: *
SAML server metadata url; *

Request timeout; *

SAML remote server X509 certificate (PFEM baseg4 encoded format,
begin/end tags are NOT needed); *

Authentication Contexts:
Local logout

Attribute for Username:
Attribute for First Name:
Attribute for Second Name:

Attribute for Groups:
Iz load-balancer or reverse-proxy in front of the local application

Scheme of load balancer server(http ar https): *
Server name of load balancer server(e.q. app.abcd.com): *

Port of the load balancer server(e.q. 443): *

When true serverPort will be used in construction of LE requestURL:

Context path of the Load Balancer(must be starting with slash, e.q.
N:*

http://localhost: 8080/ webstudio
]

7200
http://localhost: 9080/ idp-meta.xml

15000

ac:classes:PasswordProtectedTransport
]

p:ffexample.com/identity/claims/name
vample.com/identity/claims/givennames
fexample.com/identity/claims/surname

Jiewample.com/fidentity/claims/groups
https
example.com

443

O

Figure 14: Configuring SAML

The following topics describe SAML configuration:
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e Configuring SAML on Apache Tomcat with Load Balancer
e Configuring SAML on Azure Kubernetes

Configuring SAML on Apache Tomcat with Load Balancer

If OpenL Tablets WebStudio instance is deployed on Tomcat and load balancer in front of the application, add
the following lines to the Tomcat /conf/server.xml file:
<Valve className="org.apache.catalina.valves.RemoteIpValve"

internalProxies=".*"

protocolHeader="X-Forwarded-Proto"

httpsServerPort="443"
/>

Configuring SAML on Azure Kubernetes

SAML configuration on Azure Kubernetes includes the following steps:

e If the OpenlL Tablets WebStudio Docker image is deployed on Azure Kubernetes, set the parameters on the
Azure Basic SAML configuration as follows:

Azure SAML configuration parameters

Parameter Description

Identifier (Entity ID) Audience of the SAML response for IDP-initiated SSO.
Example: https://example.com/openl/webstudio/saml/metadata

Reply URL Destination in the SAML response for IDP-initiated SSO.
Example: https://example.com/openl/webstudio/saml/SSO

Logout URL Called URL for the logout operation.
Example: https://example.com/openl/webstudio/saml/SingleLogout

URLs must be accessible by Azure.

e To specify the Azure metadata URL in the Openl Tablets WebStudio, search for App Federation Metadata
URL in the Azure SAML Signing certificate.
Username, first name, last name, group, and other attributes can also be retrieved from App Federation
Metadata XML.

e Build the image with the required JDBC driver.
Openl Tablets WebStudio stores information about users and their groups in the database, so there must be
a remote database server when OpenlL Tablets WebStudio is used in Kubernetes.

e Predefine groups if OpenL Tablets WebStudio catches groups from the metadata XML by group attribute
property and external group management is selected.

For example, use the following command to add a group from Active Directory to the database:

insert into openl groups (groupname, description) VALUES (<name of group in_ ad>,
<description>);

This query adds a group to Openl Tablets WebStudio. After that, to add authorities to this group, use one of
the following approaches:

e Use default groups from OpenlL Tablets WebStudio and create a link to them as follows:
insert into openl group2group (groupid, includedgroupid) VALUES (<created group id>,
<existing group in openl with authorities>);

e Give a defined authority directly to the created group as follows:

insert into openl group authorities (groupid, authority) VALUES (<created group id>,
<existing authority id>);
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In Kubernetes, application configuration is described in the configuration map and installer must not be used.
For an example of the configuration, see Appendix B: OpenL Tablets WebStudio Image Configuration for SAML.

3.7 Configuring Microsoft Excel Settings for Apache Tomcat

The Open in Excel functionality does not work under the default settings if Apache Tomcat is installed on
Windows using Windows Service Installer as described in Installing Apache Tomcat Using Windows Service
Installer. This case requires a user to make several configuration changes.

To change DCOMConfig settings for Excel, proceed as follows:

1.

N o g &

Run the dcomconfig.exe utility using administrator credentials:

Start > dcomcnfg.exe

The Component Services window appears.

In Console Root, select Component Services > Computers > My Computer > DCOM Config.
Navigate to the Microsoft Excel Application at the right.

If Microsoft Excel Application is not available under DCOMConfig settings, on the 64 bit system with 32 bit
Office, select Start > Run mmc -32 > File > Add/Remove Snap-in... > Component Services > Add > OK >
Console Root > Component Services > Computers > My Computer > DCOM Config > Microsoft Excel
Application.

Right click Microsoft Excel Application and in the drop-down menu, select Properties.
In the Microsoft Excel Application window, click the Identity tab.

Select This user.

Click OK to complete.
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. Component Services

% File Action View Window H

= 2B XE = -
> Mex2Setup Class ]

MexiMdeOutputProfile Which user account do you want to use ta run this application?

MeetingloinAxOC
MFCongestionController

Microsoft Excel Application Properties @

| General I Location I Security I Endpoints | Identity |

Bppli

hs
@) The interactive user.

MhegVhM

Microsoft Audio Device C (©) The launching user.

Microsoft Block Level Bac .

Microsoft Excel Applicatic () This user.

Microsoft IMAPL B

m

Microsoft Qutlook
Microsoft PowerPoint Ap
Microsoft TEC Server
Microsoft Volume Shado
Microsoft WBEM Active S
Microsoft WBEM Unsecw
Microsoft Windows Defer
Microsoft Windows Font
Microsoft Windows Remu

The system account (services only).

Microsoft Windows Remi
Microsoft Windows WS5MM
Microsoft Windows W5SM
Microsoft WMI Provider £
Microsoft WMI Provider £
Microsoft Word 97 - 2003
MMC Application Class

MSDAINITIALIZE - oKk ][ cancel | [ Apply
4 1 2

Leam more about setting these properties.

e O L O I O 0 I 0 0 O O 0 O I I

Figure 15: Microsoft Excel application properties

3.8 Openl Tablets WebStudio Customization

This section describes additional configuration for OpenL Tablets WebStudio and includes the following topics:

e Updating User Database Configuration

e Configuring User Mode

e Configuring Google Analytics

e Configuring Private Key for Repository Security

Updating User Database Configuration

User database settings, such as connection, login, and password data, are modified using the
<OPENL_HOME>/system-settings/db.properties file.

An example of the configuration that can be used for the user database is as follows:

db.hibernate.dialect = org.hibernate.dialect.MySQLDialect
db.driver = com.mysqgl.jdbc.Driver

db.url = jdbc:mysgl://localhost:3306/openl

db.user = openl user

db.password = openl password

Configuring User Mode

Normally, user mode in OpenL Tablets WebStudio is set to multi-user by using OpenL Tablets WebStudio
Installation Wizard as described in Setting Up OpenL Tablets WebStudio with Installation Wizard.
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User mode can also be changed as a JVM option for Tomcat. For that, open the Apache Tomcat Properties
dialog as described in Installing Apache Tomcat Using Windows Service Installer, and in the Java Options text
box, add the following line:

-Duser.mode=multi

Note: User mode set as a Java option takes precedence over the corresponding value specified in the OpenL Tablets
WebStudio Installation Wizard. If both are defined, the Java option value is used.

Configuring Google Analytics

Google Analytics is a service offered by Google that generates detailed statistics about website traffic and traffic
sources. To configure Google Analytics for OpenL, open the Apache Tomcat Properties dialog as described in
Installing Apache Tomcat Using Windows Service Installer and in the Java Options text box, add the following
lines:

-Dwebstudio.analytics=number

Alternatively, configure Google Analytics for OpenL in the config.properties file located in \WEB-INF\conf\
as follows:

webstudio.analytics=number

number is @ number provided by Google during registration.

Configuring Private Key for Repository Security

OpenlL Tablets WebStudio allows connecting to secured repositories. In this case, passwords are stored in OpenL
Tablets WebStudio workspace. To improve passwords protection, a private key can be used.

Private key is a special secure sentence for coding and encoding repository passwords. By default, the private
key is empty. It can be set up as a JVM option for Tomcat by adding and specifying the value of the following
parameter:

repository.encode.decode. key.
The private key must be specified without spaces.

Note: The private key must be configured prior to creating any secured connections. Otherwise, all stored passwords
become invalid.

To enable private key usage for password encoding, modify the repository.encode.decode. key property in
the {TOMCAT HOME}\webapps{APP NAME}\WEB-INF\conf\system.properties file. By default, for OpenL
Tablets Rule Services, this property is empty, and for OpenL Tablets WebStudio, it contains the This is the key
for password secure phrase.
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4 Deploy Openl Tablets Rule Services under Apache
Tomcat

This chapter is designed for rule developers who need to use business rules as separate web services.

For more information on how to configure OpenlL Tablets Rule Services, see [OpenL Tablets Rule Services Usage
and Customization Guide].

Before deploying OpenlL Tablets Rule Services under Apache Tomcat, ensure the following tasks are performed:

e The Java HOME environment variable is set to the pathname of the directory where JDK is installed.
e JVM options are set up as described in Installing Apache Tomcat.

The folder where Tomcat is installed is referred to as <TOMCAT HOME>.
This section contains the following topics:

e Downloading Preconfigured OpenL Tablets Rule Services

e Configuring OpenL Tablets Rule Services for a Local Data Source

e Configuring OpenL Tablets Rule Services for a Database Data Source
e Configuring OpenL Tablets Rule Services via GIT Connection

4.1 Downloading Preconfigured OpenL Tablets Rule Services

To download the preconfigured OpenlL Tablets Rule Services application in a WAR file, proceed as follows:

1. Locate http://openl-tablets.org/downloads.

2. Click the appropriate OpenlL Tablets Rule Services WAR link.
3. Save the WAR file to the <ToMCAT HOME>\webapps directory.

4.2 Configuring OpenL Tablets Rule Services for a Local Data
Source

This section describes how to configure settings for a local storage with deployed projects there. The following
topics are included:

e Configuring OpenL Tablets Rule Services via Local File System
e Configuring OpenlL Tablets Rule Services via Local ZIP Archives
e Configuring Openl Tablets Rule Services via Classpath JAR

Configuring OpenlL Tablets Rule Services via Local File System

Using a file system as a data source for user projects means that projects are stored in a local folder. This folder
represents multi deployments containing one or multiple projects for each deployment. Each deployment must
be represented as a separate folder and, at the same time, the project must also be represented as a separate
folder inside the deployment folder.

To deploy OpenlL Tablets Rule Services, configure a local file system as a data source as follows:
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4. Openthe WEB-INF\classes\application.properties file.

5. Set the following properties with the following values:

production-repository.factory = repo-file
production-repository.uri = d:/datasource/

Note: For proper parsing of Java properties file, the path to the folder must be defined with a slash (‘/’) as the folders
delimiter. Back slash “\” is not allowed.
6. Save the rule project in the appropriate datasource folder.

Every rule project must be represented as a separate folder. As an example, use OpenlL Tablets Tutorial
available at http://openl-tablets.org/documentation/tutorials.

7. TorunTomcat, in <TOMCAT HOME>\bin, click the startup.bat file.

To ensure the deployment is successful, try loading the appropriate CXF page with web services.
An example is http://localhost:8080/openl-tablets-ws-X.X.X.

Note: The Tomcat log file contains a URL that must be used to run the OpenL Tablets Rule Services. For a file system data
source, the URL must resemble http://localhost:8080/<ws war file name>/<rule project
url>?wsdl, where <rule project url>can be taken from the Tomcat log file.

Users can also pack their rule projects in a jar file and use this file as a data source as described in [OpenL
Tablets Rule Services Usage and Customization Guide], JAR File Data Source section.

Configuring OpenlL Tablets Rule Services via Local ZIP Archives

Using a local zip archive as a data source for user projects means that zipped projects are stored in a local folder.
This folder represents rule project or deployment as a separate zip archive:

e Each dependent rule projects must be represented as a deployment zip archive and each project must be in
a separate folder inside the deployment archive.
e Each independent rule project must be represented as a separate zip archive.

To set up local zip archives for deployment to OpenlL Tablets Rule Services, proceed as follows:

1. Openthe WEB-INF\classes\application.properties file.

2. Set the following properties with the following values:
production-repository.factory = repo-zip
production-repository.uri = d:/datasource

3. Save the zipped rule projects in the appropriate datasource folder.

Every rule project must be represented as a separate archive. As an example, use Openl Tablets tutorial
available at http://openl-tablets.org/documentation/tutorials.

It is also possible to configure separate zip archives from different locations. For that, set up the production-
repository.archives property and define the exact address to the zip archive. Use the comma “,” separator to
configure multiple archives. An example is as follows:

production-repository.archives = d:/datasource/projectl.zip, c:/folder/project2.zip

Configuring OpenlL Tablets Rule Services via Classpath JAR

If rule projects with the rules.xml project descriptor in the archive root or deployments with the
deployment.xml Or deployment .yaml deployment descriptor in the archive root are packed into a JAR file and
placed in the c1asspath, these projects are deployed at the application launch. It is default configuration.

To set up a classpath JAR for deploy to OpenL Tablets Rule Services, proceed as follows:
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1. Openthe WEB-INF\classes\application.properties file.
Set the following properties with the following values:
production-repository.factory = repo-jar
3. Put the JAR file with the project to \<TOMCAT HOME>\webapps\<rule services file name>\WEB-INF\lib.

Alternatively, zip archives with deployments or rule projects can be saved to \<TOMCAT HOME>\webapps\<rule
services file name>\WEB-INF\classes\openl.

4.3 Configuring OpenL Tablets Rule Services for a Database
Data Source

This section describes how to configure settings to connect to a database for storing deployed projects there.
Such configuration requires that the appropriate database exists and is launched. The following topics are
included:

e Configuring Openl Tablets Rule Services via JDBC Connection
e Configuring Openl Tablets Rule Services via JNDI Connection
e Configuring Openl Tablets Rule Services via AWS S3 Connection

Before configuration, add the appropriate driver library for a database in Openl Tablets Rule Services to \WEB-
INF\1ib\.Alternatively, locate required libraries directly in \<ToMCAT HOME>\1ib with other Tomcat libraries.
Install the database, defining a login and password and creating a new schema or service.

For more information on drivers, see the Driver name for appropriate databases table in Adding Drivers and
Installing and Configuring the Database.

Configuring OpenL Tablets Rule Services via JDBC Connection

To set up JDBC connection settings for OpenlL Tablets Rule Services, proceed as follows:

1. Open the WEB-INF\classes\application.properties file.

2. Set the following properties with the following values:

production-repository.factory = repo-jdbc
production-repository.uri = jdbc:mysgl://localhost/deployment-repository

3. Set the URL value for production-repository.uri according to the appropriate database as described in
the URL value according to the database type table in Setting Up OpenL Tablets WebStudio with Installation
Wizard.

4. Setthe Iogin production-repository.login and paSSWOFd production-repository.password for
connection to the database defined while installing the database.

The password must be encoded via the Base64 encoding schema when repository.encode.decode.key is
also defined.

Configuring OpenlL Tablets Rule Services via JNDI Connection

This section describes how to configure JNDI connection when OpenL Tablets Rule Services is started under
Apache Tomcat. Before configuration, ensure that resources are set up in the context.xml file as described in
Configuring Resources for JNDI Context.

To configure Openl Tablets Rule Services via JNDI connection, proceed as follows:
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Open the WEB-INF\classes\application.properties file

Set the following properties with the following values:

production-repository.factory = repo-jndi

production-repository.uri = java:comp/env/jdbc/deploymentDB

Change the URL value for production-repository.uri according to the appropriate database as described
in the URL value according to the database type table in Setting Up Openl Tablets WebStudio with
Installation Wizard.

Note: Login and password are not required for definition inside the application.properties file while

configuring JNDI settings.

Configuring OpenL Tablets Rule Services via AWS S3 Connection

This section describes how to configure an AWS S3 connection when OpenlL Tablets Rule Services is started
under Apache Tomcat.

To configure OpenL Tablets Rule Services via an AWS S3 connection, proceed as follows:

1.

Build a customized version of OpenL Tablets Rule Services with dependencies on

*org.openl.rules.repository.aws v5.20.54 =*:

Create a pom.xml file with the following content for this:

<?xml version="1.0" encoding="UTF-8"?>
<project xmlns="http://maven.apache.org/POM/4.0.0"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaLocation="http://maven.apache.org/POM/4.0.0 http://maven.apache.org/maven-
vd 0 0.xsd">

<modelVersion>4.0.0</modelVersion>

<groupId>com.example.openl</groupId>

<artifactId>webservice-aws</artifactId>

<packaging>war</packaging>

<version>1.0-beta</version>

<properties>
<project.build.sourceEncoding>UTF-8</project.build.sourceEncoding>
<org.openl.version>#Define Openl Tablets version here#</org.openl.version>
</properties>
<dependencies>
<dependency>
<groupId>org.openl.rules</groupId>
<artifactId>org.openl.rules.repository.aws</artifactId>
<version>${org.openl.version}</version>
</dependency>
<dependency>
<groupId>org.openl.rules</groupId>
<artifactId>org.openl.rules.ruleservice.ws</artifactId>
<type>war</type>
<version>${org.openl.version}</version>
</dependency>
</dependencies>
<dependencyManagement>
<dependencies>
<dependency>
<groupId>com.fasterxml.jackson.core</groupId>
<artifactId>jackson-databind</artifactId>
<version>2.11.4</version>
</dependency>
<dependency>
<groupId>com.fasterxml.jackson.core</groupId>
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<artifactId>jackson-annotations</artifactId>
<version>2.11.4</version>

</dependency>

<dependency>
<groupId>commons-codec</groupIld>
<artifactId>commons-codec</artifactId>
<version>1.15</version>

</dependency>

</dependencies>
</dependencyManagement>
</project>

2. Add the following properties to the application.properties file:

production-repository.factory = repo-aws-s3
production-repository.bucket-name = yourBucketName
production-repository.region-name = yourS3Region
production-repository.access-key = yourAccessKey
production-repository.secret-key = yourSecretKey

4.4 Configuring Openl Tablets Rule Services via GIT

Connection

To configure OpenL Tablets Rule Services via a GIT connection, build a customized version of OpenL Tablets Rule

Services with dependencies On org.openl.rules: org.openl.rules.repository.git as well:

1. Create a pom.xml file with the following contents:
<?xml version="1.0" encoding="UTF-8"?>
<project xmlns="http://maven.apache.org/POM/4.0.0"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

xsi:schemalocation="http://maven.apache.org/POM/4.0.0 http://maven.apache.org/maven-

v4d 0 0.xsd">
<modelVersion>4.0.0</modelVersion>
<groupId>com.example.openl</groupId>
<artifactId>webservice-git</artifactId>
<packaging>war</packaging>
<version>1l.0-beta</version>

<properties>

<project.build.sourceEncoding>UTF-8</project.build.sourceEncoding>

<org.openl.version>#Define OpenlL Tablets version here#</org.openl.version>

</properties>
<dependencies>
<dependency>
<groupId>org.openl.rules</groupId>
<artifactId>org.openl.rules.repository.git</artifactId>
<version>${org.openl.version}</version>
</dependency>
<dependency>
<groupld>org.openl.rules</groupId>
<artifactId>org.openl.rules.ruleservice.ws</artifactId>
<type>war</type>
<version>${org.openl.version}</version>
</dependency>
</dependencies>
<dependencyManagement>
<dependencies>
<dependency>
<groupId>com.fasterxml.jackson.core</groupId>
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<artifactId>jackson-databind</artifactId>
<version>2.11.4</version>
</dependency>
<dependency>
<groupId>com.fasterxml.jackson.core</groupId>
<artifactId>jackson-annotations</artifactId>
<version>2.11.4</version>
</dependency>
<dependency>
<groupld>commons-codec</groupIld>
<artifactId>commons-codec</artifactId>
<version>1.15</version>
</dependency>
</dependencies>
</dependencyManagement>
</project>
2. Add the following properties to the application.properties file:
production-repository.factory = repo-git
production-repository.uri = https://github.com/<your-name>/<your-repo>.git
production-repository.login = your-login
production-repository.password = your-password
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5 Install Openl Tablets WebStudio and OpenlL
Tablets Rule Services on WebSphere Application
Server

This section explains how to install OpenL Tablets WebStudio and OpenlL Tablets Rule Services on WebSphere
Application Server. The following topics are included:

e Prerequisites

e Setting Up JVM Options for WebSphere Application Server

e Preparing Openl Tablets WAR Files

e Deploying OpenL Tablets Web Applications on WebSphere Application Server
e Configuring Settings for JDBC Connection

e Configuring Settings for JNDI Connection

e Configuring Microsoft Excel Settings for WebSphere Application Server

5.1 Prerequisites

Before deploying OpenL Tablets WebStudio on WebSphere Application Server, IBM WebSphere Application
Server v. 8.5 or later must be installed on the user’s local machine, or users must be granted access to a
WebSphere Application Server instance with logon that has appropriate permissions to configure JVM options.

For more information on how to install IBM WebSphere Application Server, see Oracle online documentation,
section Installing and Configuring WebSphere 8.5 at
http://docs.oracle.com/cd/E24902 01/doc.91/e23435/inst config was85 win.htm

IMPORTANT! When defining the Shared Resource Directory during the installation process, the path to the
directory must be specified without spaces. Otherwise, OpenL Tablets WebStudio fails.

5.2 Setting Up JVM Options for WebSphere Application
Server

To set up JVM options for WebSphere Application Server, proceed as follows:

1. In WebSphere Application Server Console, navigate to Servers/ServerTypes/WebSphere Application
Servers.
The server appears in the right pane.

2. Inthe right pane, click the server name.

The default value is serverl.

Locate the Server Infrastructure area and expand the Java and Process Management node.

Click Process definition.

In the upper right part of the window, click the Java Virtual Machine link.

In the Initial heap size text box, enter 256.

N o g Mw

In the Maximum heap size text box, enter 1024.
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8. Inthe Generic JVM Arguments, add the following line:

-XX:+UseParallelOldGC -XX:PermSize=128m -XX:MaxPermSize=384M -
Dclient.encoding.override=UTF-8

9. Click OK.

10. In the Message window which appears in the top of the form, click Save directly to the master
configuration to save changes.

11. Restart WebSphere Application Server.

5.3 Preparing Openl Tablets WAR Files

This section describes how to configure Openl Tablets WebStudio and OpenL Tablets Rule Services WAR files.
Proceed as follows:

1. Locate http://openl-tablets.org/downloads.

Click the appropriate OpenL Tablets WAR link.

Save the file in a temporary folder.

Open the downloaded WAR file as a ZIP archive.

In the \weB-INF\1ib\ folder, remove the following JAR files:

o~ D

e jboss-transaction-api_1.2_spec-1.0.0.Final.jar
e geronimo-jta_1.1_spec.jar
6. Save the WAR file.

5.4 Deploying OpenL Tablets Web Applications on
WebSphere Application Server

This section describes how to deploy OpenL Tablets WebStudio and OpenlL Tablets Rule Services on WebSphere
Application Server and includes the following topics:

e Deploying OpenlL Tablets WebStudio on WebSphere Application Server
e Deploying OpenlL Tablets Rule Services on WebSphere Application Server

Deploying Openl Tablets WebStudio on WebSphere Application Server
To deploy OpenL Tablets WebStudio on WebSphere Application Server, proceed as follows:

1. In a browser, enter the following URL:
https://localhost:9043/ibm/console
This is a default port for local installation. The WebSphere Application Server Console window appears.
2. Navigate to Applications / Application Types / WebSphere enterprise applications.
3. Inthe top line tool bar, click the Install button.
4. Inthe Path to the new application area, select the modified OpenL Tablets WebStudio WAR file.
The Local file system option is selected by default.
5. Click Next till Step 2.
6. Inthe Step 2: Map modules to servers page, select the check box on the left to the file name and click Next.
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7. Inthe Step 3: Map virtual hosts for Web modules page, select the check box on the left to the file name and
click Next.

8. In the Step 4: Map context roots for Web modules page, in the Context Root text field, enter /webstudio
and click Next.

9. Click Finish to complete.
10. When the installation process is complete, click the Manage Applications link.
11. In the next window, in the list of applications, click the OpenL Tablets WebStudio WAR file link.
12. In the next window, locate the Detail Properties area and click the Class loading and update detection link.
13. In the next window, select the following radio buttons:
e C(Classes loaded with local class loader first (parent last)
o Single class loader for application
14. Click OK to finish.
15. In the next window, click the Save directly to the master configuration link.
Now the Openl Tablets WebStudio application is installed and started. If not, start the application.
16. Run Openl Tablets WebStudio by entering http://localhost:9080/webstudio/ in a browser.

The Welcome to OpenL Tablets WebStudio Installation Wizard window appears allowing to set up the
application as needed. For more information on the application setup, see Configuring External User
Database, Setting Up Openl Tablets WebStudio with Installation Wizard and OpenL Tablets WebStudio
Customization.

Deploying OpenlL Tablets Rule Services on WebSphere Application Server

To deploy OpenlL Tablets Rule Services on WebSphere Application Server, complete steps 1-16 described in
Deploying Openl Tablets WebStudio on WebSphere Application Server.

For more information on configuring the OpenL Tablets Rule Services settings, see Deploy OpenL Tablets Rule
Services under Apache Tomcat.

5.5 Configuring Settings for JDBC Connection

To configure Openl Tablets WebStudio or OpenL Tablets Rule Services, prepare war files as described in
Preparing Openl Tablets WAR Files and then do one of the following:

e Configuring OpenL Tablets WebStudio via JDBC Connection
e Configuring OpenlL Tablets Rule Services via JDBC Connection

5.6 Configuring Settings for JNDI Connection

This section describes configuring JNDI connection settings and includes the following topics:

e Configuring Global JNDI Context
e Configuring Local JNDI Context

Configuring Global JNDI Context

To configure global JNDI settings, perform the following actions:
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e Configuring Authentication Data
e Defining a JDBC Provider
e Creating a Data Source

Configuring Authentication Data

To configure authentication data, proceed as follows:
1. Open the https://localhost:9043/ibm/console login page.

2. Select Security — Global > Authentication > Java Authentication and Authorization Service.
3. Click J2C authentication data.
4. Inthe window that appears, click New, fill in all mandatory fields, and click Ok and Save.

Global security

Global security » JAAS - J2C authentication data = New...

Specifies a list of user identities and passwords for Javal(TM) 2 connector security o use,

General Properties

# Alias
|Ml,lOrac|e2

# User ID
[wLvmKowvA

# Password

Dezcription

fpply || oK || Reset || Cancel |

Figure 16: Setting up global security in WebSphere

Defining a JDBC Provider

To define a JDBC provider, proceed as follows:

1. Inthe Resources section on the left panel, click JDBC providers and select the appropriate scope of the
current user and server.

[E Scope: Cell=WLYNKOVANodel1Cell, Node=VLYNKOVANodel1, Server=serverl

Scope specifies the level at which the resource definition is visible. For detailed information on what scope is and how
it works, see the scope settings help.

‘ Node=VLYNKOVANcd=0l, Server=serverl Izl

Figure 17: Configuring scope for new JDBC provider

2. Click New to create a provider.

3. Select the required Database type, for example, Oracle, Provider type, for example, Oracle JDBC Driver,
Implementation type, for example, Connection pool data source, enter the name, and click Next.
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Create new JDBC provider

Set the basic configuration values of a JDBC provider, which encapsulates the specific
vendor JIDBC driver irmplernentation claszzes that are required to access the databaze, The
wizard fills in the narme and the description fields, but you can type different values,

Scope

|ce||s WLrMEOSVANodellCellinode s iWivMEOWVANodeDl i servers i servarl

# Database type

| Oracle

# Provider type
| Oracle JDBC Driver IEI

# Implermentation type
| Connection pool data source |Z|

* Marme
|Orac|e IDBC Driver2

Figure 18: Creating a JDBC provider

4. Inthe next page, fill in the location to appropriate driver for the Oracle database as described in the
following example excluding the name of library itself:

Directory location for "ojdbcs.jar” which is saved as WebSphere variable ${ORACLE_JDBC_DRIVER_PATH}

||::"t

Figure 19: Defining the location of appropriate database lib

5. Click Ok and Finish on the last installation page.
6. Click Save to complete and save provider.

Creating a Data Source
To create a data source, proceed as follows:
1. In Data source section, select the appropriate scope of the current user and server.

2. Click New.
3. Provide basic data source information, such as data source name and JNDI name.

Scope

|ce||5 AWOrHEOVANodeDlCellinodes  WLYHKOWANode Dl i serversserverl

4 Data zource narme
|M','C-rac|eD52

# JMDT name
|n:nrac|eJNDI

Figure 20: Configuring a data source

4. Click Next.
5. Select a JDBC provider and click Next.
6. Define URL of the appropriate data user to connect to.
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An example is jdbc:oracle:thin:@localhost:1521:orcl.

7. Ensure that the Use this data source in container managed persistence (CMP) option is cleared and click
Next.

8. Define authentication settings.

Setup security aliases

Select the authentication values for this resource,

Component-rmanaged authentication alias
| WLFMESWANode 0l My Sracle2 |EI

Mapping-configuration alias

[mone)

Container-rmnanaged authentication alias
| VLYMEOWANadeD 1/ MyDracle 2 Izl

Mote: v¥ou can create a new 12C authentication alias by acceszsing one of the following
links., Clicking an a link will cancel the wizard and vour current wizard selections will be lost,

Global 12C authentication alias
Security dormains

Figure 21: Configuring a data source

9. Click Next and Finish and then save the created configuration.

When the JNDI connection is created and saved, a user can connect to the database where deployment
repository will be stored. The database URL, that is, JNDI name, must have a short version of it without
prefixes java:comp/env/jdbc/ because it is configured as a global JNDI context.

Deployment Repositories

Deployment storages of deployed rule projects where solution applications use them.

Name: * Deployment
Type: # Database (JNDI) B
URL: * oracleJNDI

Figure 22: Connecting to the database in OpenL Tablets WebStudio via global JNDI context

To start OpenlL Tablets WebStudio on WebSphere, proceed as described in Deploying OpenL Tablets WebStudio
on WebSphere Application Server.

To start OpenlL Tablets Rule Services on WebSphere, proceed as described in Deploying OpenL Tablets Rule
Services on WebSphere Application Server.
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# In case of DB via JNDI this property defines how to access 71t
production-repository.factory = org.openl.rules.repository.factories.IndiDBRepositoryFactory
production-repository.uri =oraclelJNDI

Figure 23: Configuration settings for OpenL Tablets Rule Services via global JNDI context

Configuring Local JNDI Context

Typically, Enterprise JavaBeans (EJB) does not use the global name to look up the data source while configuring
JNDI connection in an enterprise application, such as WebSphere. Instead, EJB uses a logical INDI name that is
mapped to the global JNDI name of the data source. Proceed as follows:

1. To map alogical INDI name to the global JNDI data source name, declare a resource reference in the
deployed application \WEB-INF\web.xm1l file as follows:

<resource-ref>
<description>Resource reference to a factory for java.sqgl </description>
<res-ref-name>jdbc/JINDIName</res-ref-name>
<res-type>javax.sql.DataSource</res-type>
<res—auth>Container</res-auth>

</resource-ref>

The value of the <res-ref-name> tag is a logical JINDI name EJB uses to look up the data source. The value of
the <jndi-name> tagis a global name of the data source to which the logical name is mapped.

2. When the resource reference settings are added, save the file and repack the application.
3. Start deploying OpenL Tablets WebStudio or OpenlL Tablets Rule Services as described in Deploying OpenL
Tablets WebStudio on WebSphere Application Server, steps 1-5.

4. Inthe Map resource references to resources window, in the Set Multiple NDI Names list, select Target
Resource JNDI Name and click Next.

Map resource references to resources

Each rescurce referengz that is defined in your application must be mapped to a rescurce.

Set Multiple JNDI Names = | Modify Resource Authentication Method... Extended Properties...
jdbc/DefaultEIBTimerDataSource
oracleDBZ
jdbc/IpbDB
DefaultDatasource
oracle]NDI Rescurce ] - ’
ST === Target Resource JNDI Name Login configuration
Reference
Resource
authorization:
oracle]NDI i
Openl Web ves.vear, WEB- $dbefioracleINDT |B SEnErEr
Service INF/ web.xml growse... o i
method:
Naone

Figure 24: Configuring mapping for a local JINDI context

5. Complete configuration as described in Deploying OpenL Tablets WebStudio on WebSphere Application
Server, steps 7-16.
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5.7 Configuring Microsoft Excel Settings for WebSphere
Application Server

The Open in Excel functionality does not work if WebSphere Application Server 8.5 is used under default
settings. Execute configuration changes described in Configuring Microsoft Excel Settings for Apache Tomcat.
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6 Install Openl Tablets WebStudio and OpenlL
Tablets Rule Services on JBoss Application Server

This section explains how to install OpenL Tablets WebStudio and OpenL Tablets Rule Services on JBoss
Application Server in a standalone mode.

The following topics are included:

e Deploying OpenL Tablets WebStudio on JBoss Application Server

e Deploying OpenL Tablets Rule Services on JBoss Application Server
e Setting Up a JDBC Connection

e Setting Up a JNDI Connection

6.1 Deploying OpenL Tablets WebStudio on JBoss
Application Server

To deploy OpenlL Tablets WebStudio on JBoss Application Server, proceed as follows:
1. Rename the Openl Tablets WebStudio war file to webstudio.war.
2. Copy webstudio.war to the <JBoss home directory>\standalone\deployments directory.

3. Ifthe auto-deploy-zipped attribute is set to true in the standalone.xml file, manually create an empty
file webstudio.war. dodeploy.

Run the <JBoss home directory>\bin\standalone.bat file.

Verify that the webstudio.war.deployed marker is generated.

To run Openl Tablets WebStudio, in a browser, enter http://localhost:8080/webstudio/.
The Welcome to OpenlL Tablets WebStudio Installation Wizard window.

© N o U b

Set up the application as required.

6.2 Deploying OpenL Tablets Rule Services on JBoss
Application Server

To deploy OpenlL Tablets Rule Services on JBoss Application Server, proceed as follows:

1. Rename the OpenlL Tablets Rule Services file to webservice.war.

Copy the webservice.war file to the <JBoss home directory>\standalone\deployments directory.
Run the <JBoss home directory>\bin\standalone.bat file.

Verify that the webservice.war.deployed marker is generated.

o~ wD

To run OpenL Tablets Rule Services, in a browser, enter http://localhost:8080/webservice/.
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6.3 Setting Up a JDBC Connection

To set up a JDBC connection for OpenL Tablets WebStudio, proceed as follows:

1.

2
3
4.
5

Download a required JDBC driver.

Run < JBoss home directory >\bin\standalone.bat.

Run JBoss command line client <dBoss home directory>\bin\jboss-cli.bat.
In Jboss-cli:, connect to the server using the connect command.

In Jboss-cli:, add a module using the following command:

module add --name=<module name> --resources=<path to the driver> --
dependencies=javax.api, javax.transaction.api

An example of the MySQL driver copied to the <JBoss home directory>\bin directory is as follows:

module add --name=org.mysqgl --resources=mysqgl-connector-java-8.0.11l.jar --
dependencies=javax.api, javax.transaction.api

To prepare *.war files for deployment, in the META-INF\jboss-deployment-structure.xml file, add the
following structure:
<dependencies>

<module name="<module name>" export="true" />

</dependencies>

For webservice.war, inthe application.properties file, specify a connection to the database as follows:

production-repository.factory = org.openl.rules.repository.db.JdbcDBRepositoryFactory
production-repository.uri = jdbc:mysqgl://localhost/deployment-repository

Ensure that the application.properties file is “visible” at the JBoss launch location.

For example, if the application.properties file is located in JBoss home directory, JBoss must be run
from this directory via the bin\standalone.bat command.

Configure a JDBC connection for OpenL Tablets WebStudio as described in Configuring OpenL Tablets
WebStudio via JDBC Connection.

6.4 Setting Up a JNDI Connection

To set up a JNDI connection settings for OpenlL Tablets WebStudio, proceed as follows:

N o v s~ W N Re

Copy a database driver to the <JBoss home directory>\ standalone\deployments\ directory.
Run the <JBoss home directory>\bin\standalone.bat file.

In a browser, enter http.//localhost:8080/.

Click Administration console.

Click the Configuration link.

Select Subsystems > Datasources > Non-XA.

Click Add.
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Home  Deployments = Configuration Runtime  Access Control Patching

Configuration Subsystem (30) Type Datasource %
Subsystemns > Q Non-XA > ExampleD5

Interfaces ICA XA >

Sacket Binding Datasources *

Paths Resource Adapters &

System Properties Ma b

Transactions

EB3

Figure 25: Configuring a JNDI connection
8. In the Create Datasource window, select a data source and click Next.
9. Enter the data source name and JNDI name and click Next.

10. Switch to the Detected Driver tab.

Create Datasource « R
Step 2/3: JDBC Driver 3
Select one of the installed |DBC drivers. If you do not see your driver, make sure
that it is deployed as a module and properly registered.

Specify Driver etected Driver

Name
h2
mysql-connector-java-8.0.11.jar
1-6of B
Cance « Back Next
A

Figure 26: JDBC Driver collection
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11. Select a JDBC driver and click Next.

12. Specify database connection settings and click Next.
13. To test the JDBC connection, click Test Connection.
14. Click Next and then click Finish.

15. For webservice.war, in the application.properties file, specify the connection to a database as follows:

production-repository.factory =
org.openl.rules.repository.db.DatasourceDBRepositoryFactory

production-repository.uri = <JNDI Name>

16. Configure a JNDI connection for OpenL Tablets WebStudio as described in Configuring Settings in OpenL
Tablets WebStudio.
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7 Openl Tablets WebStudio and Rule Services
Integration

This section describes how to set up OpenL Tablets WebStudio and OpenlL Tablets Rule Services integration and
enable backward compatibility and includes the following topics:

e Deploying Rules to the Production Server
e Integrating Openl Tablets WebStudio and Openl Tablets Rule Services via Database Repository

7.1 Deploying Rules to the Production Server

After integration any changes can be made in user’s rule in Openl Tablets WebStudio, and then the project must
be saved and redeployed. These changes immediately affect the rule represented as web service. During
development, rules are stored in the file system of the development server. When development is finished, rules
can be deployed to the production server as follows:

1. Openl Tablets WebStudio sends the rules project to the database repository, using the JDBC driver for
connection, in case of integration via database repository.
[ ]

2. The rules are saved on the production server.

3. Openl Tablets Rule Services detects a new version of the deployed rules and starts using it.
The following diagram illustrates the OpenL Tablets WebStudio and OpenlL Tablets Rule Services integration:

Application Instance Application Instance

Openl Tablets WebStudio Deployment

A ;
Repository Web Services

E QpenL Tablets

| ¥

OpenL Design
Working Repository
Directory

Figure 27: Openl Tablets WebStudio and Openl Tablets Rule Services deployment

© 2004-2021 Openl Tablets
OpenlL Tablets 5.25 Page 56 of 62



OpenlL Tablets Installation Guide OpenlL Tablets WebStudio and Rule Services Integration

7.2 Integrating Openl Tablets WebStudio and OpenlL
Tablets Rule Services via Database Repository

This section describes an alternative way of how to set up an integrated environment that enables work with
business rules from OpenlL Tablets WebStudio and launch these rules as OpenL Tablets Rule Services. To set up
Openl Tablets WebStudio and OpenL Tablets Rule Services integration using the database as storage for
deployment repository, proceed as follows:

1. Install OpenL Tablets WebStudio and OpenL Tablets Rule Services on the same application server.
2. Connect OpenL Tablets WebStudio to the database to store deployed projects as described in Setting Up
Openl Tablets WebStudio with Installation Wizard.

3. Configure OpenL Tablets Rule Services for a database data source as described in Configuring OpenL Tablets
Rule Services for a Database Data Source.
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8 Troubleshooting Notes

If OpenL Tablets WebStudio is deployed under Tomcat in the Unix/Linux environment, consider the following
troubleshooting recommendations:

1.

Before starting Tomcat under Linux, make sure that no Java processes are running:

sudo ps -A | grep j

If found, the process name and number are displayed.

If any Java process is running, stop it as follows:

kill -9 <process number>

Make sure that port 8080 is available as follows:

sudo netstart —an | grep 8080

Run Tomcat under Linux as follows:

<TOMCAT HOME>/bin/startup.sh

If the command not found error appears, mark the . sh file as an executable script as follows:
chmod +x startup.sh

If the Permission denied or The BASEDIR environment variable is not defined correctly error is displayed,
make all . sh files in the bin folder executable as follows:

chmod 777 *.sh

Verify that all . sh files in the bin folder are executable as follows:

ls -1la

Run Tomcat as follows:

<TOMCAT HOME>/bin/startup.sh
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9 Frequently Asked Questions

This section provides the most common questions and answers related to the OpenL Tablets installation
procedure. For more information on working with Java, Tomcat, and other third party software, see the

corresponding sites of the software manufacturers.

Frequently Asked Questions

# Question

Answer

1 How can | check if Java is installed on my PC?

Proceed as follows:

1. Open Start > Control Panel.

2. Perform either of the following:
e For Windows XP, double click Add or Remove Programs.
e For Windows 7/Vista, click Programs > Programs and

Features.

3. Look through the list for Java(TM)... or Java(TM) Update...

items. If any is present, Java is installed on your PC.

2 During Java installation, the page for Java
registration appears. Do | have to register Java?

No, it is optional. You can close the registration page.

3 How can | check which version of Java is
installed on my PC?

Open the Verify Java Version page and click the Verify Java
Version button.

In a few seconds a new page appears where you will find the

message like the following one: Your Java version: Version 6
Update 26.

4  How can | see the error message in the Tomcat
console that appears when | start Tomcat? The
error screen disappears too quickly.

Proceed as follows:

1. Click Start > Run.

2. Llocate the <TOMCAT HOME>\Dbin folder.

3. Select catalina.bat and enter run in the command line.
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Appendix A: Official Docker Images for OpenlL
Tablets

Openl Tablets supports Docker containers. The following table provides links to the Docker images for OpenL
Tablets:

Docker images for OpenL Tablets

Openl Tablet resource Reference

Openl Tablets Rule Services https://hub.docker.com/r/openltablets/ws/

Openl Tablets WebStudio https://hub.docker.com/r/openltablets/webstudio/
Openl Tablets demo https://hub.docker.com/r/openltablets/demo/
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Appendix B: OpenL Tablets WebStudio Image
Configuration for SAML
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apiVersion: vl
kind: Pod

metadata:

name: webstudio
labels:
app: webstudio

spec:

containers:
- image: "example.com/openl-tablets:webstudio"
name: webstudio
imagePullPolicy: Always
env:
- name: WEBSTUDIO CONFIGURED
value: "true"
- name: SECURITY SAML IS-APP-AFTER-BALANCER
value: "true"
- name: SECURITY SAML ATTRIBUTE LAST-NAME
value: http: schemas.example.com/ws/2020/07/identity/claims/surname
- name: SECURITY SAML LOCAL-LOGOUT
value: "true"
- name: SECURITY_SAML_APP—URL
value: https://a .example.com
- name: SECURITY SAML ATTRIBUTE GROUPS
value: http://schemas.example.com/ws/2020/07/identity/claims/groups
- name: SECURITY SAML ATTRIBUTE USERNAME
value: http://schemas.example.org/ws/2020/07/identity/claims/name
- name: SECURITY SAML SERVER-CERTIFICATE
value: "base6dcertificate"
- name: SECURITY SAML SAML-SERVER-METADATA-URL
value: https://example.com
- name: SECURITY SAML SERVER-NAME

value: "app.example.com"
- name: SECURITY SAML ATTRIBUTE FIRST-NAME
value: http: schemas.example.org/ws/2020/07/identity/claims/givenname

- name: USER MODE
value: saml
- name: DB URL
value: jdbc:postgresqgl://example.com:5432/openl db
- name: DB USER
value: pgadmin@postgres
- name: DB PASSWORD
value: example

ports:
- containerPort:
protocol: TCP
imagePullSecrets:

- name: regcred

Figure 28: OpenlL Tablets WebStudio Kubernetes configuration map example
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Appendix C: CORS Filter Support Enablement in
Openl Tablets WebStudio

Cross-Origin Resource Sharing (CORS) is a specification which is a standard mechanism that enables cross-origin
requests. For more information on how to enable CORS filter support in OpenL Tablets WebStudio, see [OpenlL
Tablets Rule Services Usage and Customization Guide], the CORS Filter Support section.
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